# CONTENTS

1. **Introduction**
   - Special features .............................................................................................................. 1.1
   - Printer overview .............................................................................................................. 1.2
   - Understanding the Status LED ............................................................................................ 1.4
   - Finding more information ...................................................................................................... 1.4

2. **System setup**
   - Using control panel menus .................................................................................................... 2.1
   - Menu overview .......................................................................................................................... 2.1
   - Printing a demo page .............................................................................................................. 2.7
   - Changing the display language ................................................................................................. 2.7
   - Using toner save mode ............................................................................................................ 2.7

3. **Software overview**
   - Supplied software .................................................................................................................... 3.1
   - Printer driver features ............................................................................................................. 3.2
   - System requirements ............................................................................................................... 3.2

4. **Network setup**
   - Introduction .............................................................................................................................. 4.1
   - Supported operating systems ................................................................................................. 4.1
   - Configuring TCP/IP ................................................................................................................... 4.2
   - Configuring EtherTalk ................................................................................................................ 4.2
   - Setting Ethernet speed ............................................................................................................. 4.2
   - Restoring the network configuration ......................................................................................... 4.2
   - Printing a network configuration page ...................................................................................... 4.3
   - Configuring 802.1x .................................................................................................................... 4.3
   - Configuring CentreWare IS ....................................................................................................... 4.3

5. **Loading print media**
   - Selecting print media ............................................................................................................. 5.1
   - Loading paper .......................................................................................................................... 5.4
   - Selecting an output location ...................................................................................................... 5.8

6. **Basic printing**
   - Printing a document ................................................................................................................. 6.1
   - Canceling a print job ............................................................................................................... 6.1

7. **Ordering supplies and accessories**
   - Print cartridges ...................................................................................................................... 7.1
   - Accessories .............................................................................................................................. 7.1
8. Maintenance
   Printing information page ................................................................. 8.1
   Cleaning the printer ........................................................................... 8.1
   Maintaining the print cartridge ......................................................... 8.2
   Maintenance parts ........................................................................... 8.4

9. Troubleshooting
   Clearing paper jams ........................................................................... 9.1
   Troubleshooting checklist ................................................................... 9.6
   Understanding display messages ....................................................... 9.6
   Print cartridge-related messages ...................................................... 9.8
   Solving general printing problems .................................................. 9.9
   Solving print quality problems ......................................................... 9.11
   Common Windows problems ............................................................ 9.13
   Common PostScript problems .......................................................... 9.13
   Common Linux problems ................................................................. 9.14
   Common Macintosh problems ......................................................... 9.14

10. Installing accessories
    Precautions when installing accessories ........................................ 10.1
    Installing a memory DIMM ............................................................... 10.1

11. Specifications
    Printer specifications ....................................................................... 11.1
Safety

Read these safety notes carefully before using this product to ensure you operate the equipment safely.

Your Xerox product and supplies have been designed and tested to meet strict safety requirements. These include safety Agency approval, and compliance to established environmental standards. Please read the following instructions carefully before operating the product and refer to them as needed to ensure the continued safe operation of your product.

The safety testing and performance of this product have been verified using Xerox materials only.

**WARNING:** This WARNING mark alerts users to the possibility of personal injury.

**WARNING:** This WARNING mark alerts users to heated surfaces.

**CAUTION:** This symbol indicates a Laser is being used in the equipment and alerts the user to refer to the appropriate safety information.

**WARNING:** This product must be connected to a protective earth circuit.

Operator Accessible Areas

This equipment has been designed to provide operator access to safe areas only. Operator access to hazardous areas is restricted using covers or guards, which require a tool to enable removal. Never remove these covers or guards.

Maintenance Information

1. Any operator product maintenance procedures will be described in the user documentation supplied with the product.
2. Do not carry out any maintenance on this product which is not described in the customer documentation.

**WARNING:** Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable when used on electromechanical equipment.

3. Use supplies and cleaning materials only as directed in the Operator section of this manual.
4. Do not remove covers or guards that are fastened with screws. There are no parts behind these covers that you can maintain or service.

Operational Safety Information

Your Xerox equipment and supplies have been designed and tested to meet strict safety requirements. These include safety agency examination, approval, and compliance with established environmental standards.

To ensure the continued safe operation of your Xerox equipment, follow these safety guidelines at all times:

**Do These:**

- Always follow all warnings and instructions that are marked on or supplied with the equipment.
- Before cleaning this product, unplug the product from the electrical outlet. Always use materials specifically designated for this product, the use of other materials may result in poor performance and create a hazardous situation.

**WARNING:** Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable when used on electromechanical equipment.

- Always exercise care when moving or relocating equipment.
- Always locate the machine on a solid support surface (not on plush carpet) that has adequate strength to support the weight of the machine.
- Always locate the machine in an area that has adequate ventilation and room for servicing.
- Always unplug this equipment from the electrical outlet before cleaning.

**NOTE:** Your Xerox machine is equipped with an energy saving device to conserve power when the machine is not in use. The machine may be left on continuously.

**CAUTION:** The metallic surfaces in the fuser area are hot. Please use caution when removing paper jams from this area and avoid touching any metallic surfaces.

**Do Not Do These:**

- Never use a ground adapter plug to connect the equipment to a power outlet that lacks a ground connection terminal.
- Never attempt any maintenance function that is not specifically described in this documentation.
- Never obstruct ventilation openings. They are provided to prevent overheating.
Electrical Safety Information

1. The power receptacle for the machine must meet the requirements stated on the data plate on the rear of the machine. If you are not sure that your electrical supply meets the requirements, please consult your local power company or an electrician for advice.

2. The socket outlet shall be installed near the equipment and shall be easily accessible.

3. Use the power cable that is supplied with your machine. Do not use an extension cord or remove or modify the power cord plug.

4. Plug the power cable directly into a correctly grounded electrical outlet. If you are not sure whether or not an outlet is correctly grounded, consult an electrician.

5. Do not use an adapter to connect any Xerox equipment to an electrical outlet that lacks a ground connection terminal.

6. Do not place this equipment where people might step or trip on the power cable.

7. Do not place objects on the power cable.

8. Do not override or disable electrical or mechanical interlock devices.

9. Do not push objects into slots or openings on the machine. Electrical shock or fire may result.

10. Do not obstruct ventilation openings. These openings are used to provide proper cooling to the Xerox machine.

Electrical Supply

1. This product shall be operated from the type of electrical supply indicated on the product’s data plate label. If you are not sure that your electrical supply meets the requirements, please consult a licensed electrician for advice.

   **WARNING:** This equipment must be connected to a protective earth circuit. This equipment is supplied with a plug that has a protective earth pin. This plug will only fit into an earthed electrical outlet. This is a safety feature. If you are unable to insert the plug into the outlet, contact a licensed electrician to replace the outlet.

2. Always connect equipment to a correctly grounded power outlet. If in doubt, have the outlet checked by a qualified electrician.

Disconnect Device

The power cable is the disconnect device for this equipment. It is attached to the back of the machine as a plug-in device. To remove all electrical power from the equipment, disconnect the power cable from the electrical outlet.

Emergency Power Off

If any of the following conditions occur, turn off the machine immediately and disconnect the power cable(s) from the electrical outlet(s). Contact an authorized Xerox Service Representative to correct the problem:

- The equipment emits unusual odours or makes unusual noises.
- The power cable is damaged or frayed.
- A wall panel circuit breaker, fuse, or other safety device has been tripped.
- Liquid is spilled into the machine.
- The machine is exposed to water.
- Any part of the machine is damaged.
Laser Safety Information

CAUTION: Use of controls, adjustments or performance of procedure other than those specified herein may result in hazardous light exposure.

With specific regard to laser safety, the equipment complies with performance standards for laser product set by government, national and international agencies as a Class 1 laser product. It does not emit hazardous light, as the beam is totally enclosed during all phases of customer operation and maintenance.

For Consumables

- Store all consumables in accordance with the instructions given on the package or container.
- Keep all consumables away from the reach of children.
- Never throw print cartridges or toner containers into an open flame.
- Cartridges: When handing cartridges, for example ink, fuser, etc, avoid skin or eye contact. Eye contact can cause irritation and inflammation. Do not attempt to disassemble the cartridge. This can increase the risk of skin or eye contact.

Product Safety Certification

This product is certified by the following Agency using the Safety standards listed.

<table>
<thead>
<tr>
<th>Agency</th>
<th>Standard</th>
</tr>
</thead>
</table>

This product has been manufactured under a registered ISO 9001 Quality system.

Regulatory Information

CE Mark

The CE mark applied to this product, symbolizes XEROX's declaration of conformity with the following applicable European Union Directives, as of the dates indicated:
December 12, 2006:

December 15, 2004:
March 9, 1999:

A full declaration of conformity, defining the relevant directives and referenced standards, can be obtained from your XEROX Limited representative.

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING: Changes or modifications to this equipment not specifically approved by the Xerox Corporation may void the user’s authority to operate this equipment.

WARNING: Shielded cables must be used with this equipment to maintain compliance with FCC regulations.
OpenSSL License

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org.
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young(eay@cryptsoft.com). This product includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLееay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given attribution as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library being used are not cryptographic related.
4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
THIS SOFTWARE IS PROVIDED BY ERIC YOUNG `AS IS` AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e. this code cannot simply be copied and put under another distribution licence [including the GNU Public Licence.]

Environmental Compliance

USA

Energy Star

As an ENERGY STAR® partner, Xerox Corporation has determined that (the basic configuration of) this product meets the ENERGY STAR guidelines for energy efficiency.

The ENERGY STAR and ENERGY STAR MARK are registered United States trademarks.

The ENERGY STAR Office Equipment Program is a team effort between U.S., European Union and Japanese governments and the office equipment industry to promote energy-efficient copiers, printers, fax, multifunction machine, personal computers, and monitors. Reducing product energy consumption helps combat smog, acid rain and long-term changes to the climate by decreasing the emissions that result from generating electricity.

Xerox ENERGY STAR equipment is preset at the factory. Your machine will be delivered with the timer for switching to Power Save Mode from the last copy/print out, set at 30 minutes. A more detailed description of this feature can be found in the Machine Setup Section of this guide.
Product Recycling and Disposal

European Union

Domestic/Household Environment
Application of this symbol on your equipment is confirmation that you should not dispose of the equipment in the normal household waste stream. In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be segregated from household waste. Private households within EU member states may return used electrical and electronic equipment to designated collection facilities free of charge. Please contact your local disposal authority for information. In some member states, when you purchase new equipment, your local retailer may be required to take back your old equipment free of charge. Please ask your retailer for information. Prior to disposal, please contact your local dealer or Xerox representative for end of life takeback information.

Professional/Business Environment
Application of this symbol on your equipment is confirmation that you must dispose of this equipment in compliance with agreed national procedures. In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be managed within agreed procedures.

North America
Xerox operates an equipment takeback and reuse/recycle program. Contact your Xerox sales representative (1-800-ASK-XEROX) to determine whether this Xerox product is part of the program. For more information about Xerox environmental programs, visit www.xerox.com/environment or for recycling and disposal information, contact your local authorities. In the United States, you may also refer to the Electronic Industries Alliance web site: www.eiae.org. Xerox operates a worldwide equipment take back and reuse/recycle program. Contact your Xerox sales representative (1-800-ASK-XEROX) to determine whether this Xerox product is part of the program. For more information about Xerox environmental programs, visit www.xerox.com/environment.

If you are managing the disposal of your Xerox product, please note that the product may contain lead, Perchlorate and other materials whose disposal may be regulated due to environmental considerations. The presence of these materials is fully consistent with global regulations applicable at the time that the product was placed on the market. For recycling and disposal information, contact your local authorities. In the United States, you may also refer to the Electronic Industries Alliance web site: www.eiae.org.

Perchlorate Material - This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may apply, please see www.dtsc.ca.gov/hazardouswaste/perchlorate/.

Others Countries
Please contact your local waste authorities and request disposal guidance.

EH&S Contact Information
For more information on Environment, Health and Safety in relation to this Xerox product and supplies, please contact the following customer help lines: USA: 1-800 828-6571 Canada: 1-800 828-6571 Europe: +44 1707 353 434.

- Product Safety information for US
  www.xerox.com/about-xerox/environment/enus.html
- Product Safety information for EU
  www.xerox.com/about-xerox/environment/eneu.html
1 Introduction

Congratulations on the purchase of your printer!

This chapter includes:
- Special features
- Printer overview
- Finding more information

Special features

Your new printer is equipped with several special features that improve the print quality. You can:

Print with excellent quality and high speed

- You can print up to **1200 x 1200 dpi** effective output. See the Software section.
- Your printer prints A4-sized paper at up to 33 ppm\(^a\) and letter-sized paper at up to 35 ppm. For duplex printing, your printer prints A4-sized paper at up to 17 ipm\(^b\) and letter-sized paper at up to 17.5 ipm.

Handle paper flexibly

- multi-purpose tray supports letterheads, envelopes, labels, transparencies, custom-sized materials, postcards, and heavy paper. multi-purpose tray holds up to 50 sheets of plain paper.
- **250**-sheet tray 1 and **250**-sheet optional tray 2 support plain paper in various sizes.
- Multiple output tray; select either the output tray (face-down) or the rear cover (face-up) for the most convenient access.
- Straight-through paper path capability from multi-purpose tray to the rear cover.

Create professional documents

- Print Watermarks. You can customize your documents with words, such as "Confidential". See the Software section.
- Print Booklets. This feature enables you to easily print a document to create a book. Once printed, all you have to do is fold and staple the pages. See the Software section.
- Print Posters. The text and pictures of each page of your document are magnified and printed across the sheet of paper and can then be taped together to form a poster. See the Software section.

Save time and money

- You can print on both sides of the paper to save paper (Double-sided printing).
- You can print multiple pages on a single sheet of paper to save paper (2-Up printing). See the Software section.
- You can use preprinted forms and letterhead with plain paper. See the Software section.
- This printer automatically conserves electricity by substantially reducing power consumption when not in use.

Expand the printer capacity

- The Phaser 3435 series have 64 MB of memory which can be expanded to **320 MB**. See page 10.1.
- A Network interface enables network printing.
- A PostScript 3 Emulation* (PS) enables PS printing.

- Zoran IPS Emulation compatible with PostScript 3
  - © Copyright 1995-2005, Zoran Corporation. All rights reserved. Zoran, the Zoran logo, IPS/PS3 and OneImage are trademarks of Zoran Corporation.
  - 136 PS3 fonts
  - Contains UFST and MicroType from Monotype Imaging Inc.

Print in various environments

- Your printer is compatible with Macintosh.
- Your printer comes with both Parallel and USB interfaces.
- You can also use a network interface. The Phaser 3435/DN comes with a built-in network interface, 10/100 Base TX.

\(^a\) pages per minute
\(^b\) images per minute
**Printer features**

The table below lists a general overview of features supported by your printer.

(I: Installed, O: Option, NA: Not Available)

<table>
<thead>
<tr>
<th>Features</th>
<th>Phaser 3435/DN</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEEE 1284 Parallel</td>
<td>I</td>
</tr>
<tr>
<td>USB 2.0</td>
<td>I</td>
</tr>
<tr>
<td>Network Interface (Ethernet 10/100 Base TX)</td>
<td>I</td>
</tr>
<tr>
<td>PostScript* Emulation</td>
<td>I</td>
</tr>
<tr>
<td>Duplex printing(^a)</td>
<td>I</td>
</tr>
</tbody>
</table>

*Printing on both sides of paper.

---

**Printer overview**

**Front view**

*The figure above shows an Phaser 3435/DN with all available options.*

<p>| | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>output tray</td>
<td>7</td>
<td>multi-purpose tray</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>control panel</td>
<td>8</td>
<td>front cover</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>handle</td>
<td>9</td>
<td>output support</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>paper level indicator</td>
<td>10</td>
<td>multi-purpose tray paper width guides</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>optional tray 2</td>
<td>11</td>
<td>multi-purpose tray extension</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>tray 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
1.3 <Introduction>

![Rear view and Control panel overview diagrams]

* The figure above shows an **Phaser 3435/DN** with all available options.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>control board cover</td>
<td>6</td>
</tr>
<tr>
<td>2</td>
<td>network port</td>
<td>7</td>
</tr>
<tr>
<td>3</td>
<td>USB port</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>parallel port</td>
<td>9</td>
</tr>
<tr>
<td>5</td>
<td>optional tray 2 cable connector</td>
<td></td>
</tr>
</tbody>
</table>

- **Start/Stop**: Cancels an operation at any time; resumes printing.
- **Back**: Sends you back to the upper menu level.
- **Status**: Shows the status of your printer. See page 1.4.
- **Menu**: Enters Menu mode and scrolls through the available menus.
- **LCD**: Displays the printer status, error messages and menus in progress.
- **scroll**: Scrolls through the options available in the selected menu, and increases or decreases value.
- **OK**: Confirms the selection on the display.
## Understanding the Status LED

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>• The printer is powered off.</td>
</tr>
<tr>
<td>Green</td>
<td></td>
</tr>
</tbody>
</table>
|        | • The printer is on.  
|        | • The printer can receive data from the computer. |
| Blinking | • When the backlight blinks slowly, the printer is receiving data from the computer.  
|         | • When the backlight blinks quickly, the printer is printing data. |
| Red    | | On  |
|        | • A paper jam has occurred. To solve the problem, see page 9.1.  
|        | • The front cover is open. Close the front cover.  
|        | • There is no paper in the tray. Load paper in the tray.  
|        | • The print cartridge installed is not a genuine cartridge, and you selected Stop at the NonGenuine Toner prompt. See page 9.6.  
|        | • The lifespan of the print cartridge is reached, and you selected Stop at the Toner Exhausted prompt. See page 9.6.  
|        | • The printer has stopped printing due to a major error. |
| Blinking | • A minor error is occurring and the printer is waiting for the error to be cleared. When the problem is cleared, the printer resumes printing.  
|         | • The print cartridge is totally exhausted. Remove the old print cartridge and install a new one. See page 8.3.  
|         | • The print cartridge installed is not a genuine cartridge, and you selected Continue at the NonGenuine Toner prompt. See page 9.6.  
|         | • The lifespan of the print cartridge is reached, and you selected Continue at the Toner Exhausted prompt. See page 9.6.  
|         | • The print cartridge is low. Order a new print cartridge. You can temporarily improve print quality by redistributing the toner. See page 8.3. |

## Finding more information

You can find information for setting up and using your printer from the following resources, either printed or on screen.

### Quick Install Guide
Provides information on setting up your printer and, therefore, be sure to follow the instructions in the guide to get the printer ready.

### Quick Use Guide
Provides information on using your printer or cleaning jam and, therefore, be sure to follow the instructions in the guide to use the printer.

### Online User’s Guide
Provides you with step-by-step instructions for using your printer’s full features, and contains information for maintaining your printer, troubleshooting, and installing accessories. This user’s guide also contains the Software Section providing you with information on how to print documents with your printer on various operating systems, and how to use the supplied software utilities.

**Note**
You can access the user’s guides in other languages from the Manual folder on the printer driver CD.

### Printer Driver Help
Provides you with help information on printer driver properties and instructions for setting up the properties for printing. To access a printer driver help screen, click Help from the printer properties dialog box.

### Xerox website
If you have Internet access, you can get help, support, printer drivers, manuals, and order information from the Xerox website, www.xerox.com/office/support.
Selecting a location

Select a level, stable place with adequate space for air circulation. Allow extra space for opening covers and trays.

The area should be well-ventilated and away from direct sunlight or sources of heat, cold, and humidity. Do not set the printer close to the edge of your desk or table.

Clearance space

**Front**: 500 mm (enough space so that trays can be opened or removed)

**Back**: 350 mm (enough space to allow opening of the rear cover or the duplex unit)

**Right**: 100 mm (enough space for ventilation)

**Left**: 100 mm (enough space to allow opening of the control board cover)
2 System setup

This chapter provides step by step information on setting up your printer.
This chapter includes:

• Using control panel menus
• Menu overview
• Printing a demo page
• Changing the display language

Using control panel menus

A number of menus are available to make it easy for you to change the printer settings. The diagram on the next column shows the menus and all of the menu items available in each menu. The items in each menu and the options you can select are described in more detail in the tables beginning on page 2.2.

Accessing control panel menus

You can control your printer from the printer’s control panel. You can also set the control panel menus while the printer is in use.

1 Press Menu until the menu you want appears on the bottom line of the display and press OK.
2 Press the Up/down arrow buttons until the desired menu item appears and press OK.
3 If the menu item has sub menus, repeat step 2.
4 Press the Up/down arrow buttons to access the desired setting option or the required value.
5 Press OK to save your selection.
   An asterisk (*) appears next to the selection on the display, indicating that it is now the default.
6 Press Start/Stop to return to Standby mode.
   After 30 seconds of inactivity (no key being pressed), the printer automatically returns to Standby mode.

Note

Print settings made from the printer driver on a connected computer override the settings on the control panel.

Note

Some menus may not appear in the display depending on options or models. If so, it is not applicable to your machine.

Menu overview

The control panel menus are used to configure the printer. The control panel provides access to the following menus:

- Information
  - (See page 2.2)
  - Menu Map
  - Configuration
  - Demo Page
  - PCL Font List
  - PS3 Font List
  - EPSON Font

- Layout
  - (See page 2.2)
  - Orientation
  - Simplex Margin
  - Duplex
  - Duplex Margin

- Graphic
  - (See page 2.4)
  - Resolution
  - Darkness

- Paper
  - (See page 2.3)
  - Copies
  - Paper Size
  - Paper Type
  - Paper Source
  - Tray Chaining

- System Setup
  - (See page 2.4)
  - Language
  - Power Save
  - Auto Continue
  - Altitude Adj.
  - Auto CR
  - Job Timeout
  - Maintenance
  - Clear Setting

- Emulation
  - (See page 2.5)
  - Emulation Type
  - Setup

- Network
  - (See page 2.6)
  - TCP/IP
  - EtherTalk
  - Ethernet Speed
  - Clear Setting
  - Network Info.
  - 802.1x
  - CentreWare IS

a. Available when the installed memory is larger than 128 MB.
### Information menu

This menu contains printer information pages that give details about the printer and its configuration.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Map</td>
<td>The menu map shows the layout and current settings of the control panel menu items.</td>
</tr>
<tr>
<td>Configuraton</td>
<td>The configuration page shows the printer’s current configuration. See page 8.1.</td>
</tr>
<tr>
<td>Demo Page</td>
<td>The demo page allows you to check if your printer properly performs printing. See page 2.7.</td>
</tr>
<tr>
<td>PCL Font List</td>
<td>The font sample list shows all of the fonts currently available in the selected language.</td>
</tr>
<tr>
<td>PS3 Font List</td>
<td>The font sample list shows all of the fonts currently available in the selected language.</td>
</tr>
<tr>
<td>EPSON Font</td>
<td>The font sample list shows all of the fonts currently available in the selected language.</td>
</tr>
</tbody>
</table>

### Layout menu

Use the Layout menu to define all settings relating to output.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Orientation</strong></td>
<td>Choose the default orientation of the print image on the page.</td>
</tr>
<tr>
<td></td>
<td><img src="portrait.png" alt="Portrait" /> <img src="landscape.png" alt="Landscape" /></td>
</tr>
<tr>
<td><strong>Simplex Margin</strong></td>
<td>Set the margin of print materials for one-sided printing. You can increase or decrease the value in 0.1 mm increments. The margins may differ according to the paper size and printing orientation.</td>
</tr>
<tr>
<td></td>
<td>• Top Margin: Set the top margin, from 0.0 to 250 mm.</td>
</tr>
<tr>
<td></td>
<td>• Left Margin: Set the left margin, from 0.0 to 164 mm.</td>
</tr>
<tr>
<td><strong>Duplex</strong></td>
<td>To print on both sides of paper, choose the binding edge as follows.</td>
</tr>
<tr>
<td></td>
<td>• Long Edge: Flip on the long edge. Prints pages to read like a book.</td>
</tr>
<tr>
<td></td>
<td>• Short Edge: Flip on the short edge. Prints pages to read by flipping over like a note pad.</td>
</tr>
<tr>
<td></td>
<td><img src="long_edge_portrait.png" alt="Long Edge in the Portrait orientation" /> <img src="long_edge_landscape.png" alt="Long Edge in the Landscape orientation" /></td>
</tr>
<tr>
<td></td>
<td><img src="short_edge_portrait.png" alt="Short Edge in the Portrait orientation" /> <img src="short_edge_landscape.png" alt="Short Edge in the Landscape orientation" /></td>
</tr>
<tr>
<td></td>
<td>Select Off to print on one side of the paper.</td>
</tr>
</tbody>
</table>
### Duplex Margin
In this menu, you can set the margins for double-sided printing. You can increase or decrease the value in 0.1 mm increments.

- **Top Margin**: Set the top margin, from 0.0 to 9.9 mm. The default is 5.0 mm.
- **Left Margin**: Set the left margin, from 0.0 to 9.9 mm. The default is 5.0 mm.
- **Short Binding**: Set the bottom margin of the back of the page for short binding, from 0.0 to 22 mm. The default is 0 mm.
- **Long Binding**: Set the right margin of the back of the page for long binding, from 0.0 to 22 mm. The default is 0 mm.

### Paper menu
Use the **Paper** menu to define all settings relating to print material input and output, as well as the specific print material you are using with your printer.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copies</strong></td>
<td>Set the default number of copies by selecting any number from 1 to 999. The default is 1.</td>
</tr>
</tbody>
</table>
| **Paper Size**| Select the paper size currently loaded in tray.  

- **Custom Paper**: You can configure the size for your own custom paper. Set the width from 98 mm to 216 mm, and the height from 148 mm to 356 mm. |
| **Paper Type**| Select the paper type currently loaded in tray.  

| **Paper Source**| Using this item, you can set which tray you want to use.  

- **Auto**: The printer can automatically determine the source.  
- **Manual Tray**: The printer uses **MP Tray**.  
- **Tray 2**: Available only when optional tray is installed. |
| **Tray Chaining**| When you select any other value except **Auto** from **Paper Source** and the selected tray is empty, the printer automatically prints from other trays.  

If this menu item is set to **Off**, the **Status** LED lights red and the printer doesn’t work until you insert paper into the specified tray. |
**Graphic menu**

Use the Graphic menu to change settings affecting the quality of the printed characters and images.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>Values: 600dpi-Normal, 1200dpi-Best</td>
</tr>
</tbody>
</table>

Specify the number of dots printed per inch (dpi). The higher the setting, the sharper printed characters and graphics.

- If your print jobs are mostly text, select 600dpi-Normal for the highest quality printing.
- Select 1200dpi-Best when your job contains bitmapped images, such as scanned photos or some graphics, that will benefit from enhanced line screening.

| Darkness   | Values: Plain, Light, Dark |

You can lighten or darken the print on the page by changing the toner density setting. The Plain setting usually produces the best result. Use the Light toner density setting to save toner.

**System Setup menu**

Use the System Setup menu to configure a variety of printer features.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Values: English, FRANCAIS, Espanol, Portugues B., Deutsch, Italiano...</td>
</tr>
</tbody>
</table>

This setting determines the language of the text that appears on the control panel display and information printing.


When the printer does not receive data for an extended period of time, power consumption is automatically lowered. You can set how long the printer waits before going to power save mode.

| Auto Continue | Values: Off, On |

This item determines whether or not the printer continues printing when it detects the paper is mismatched with your paper setting.

- Off: If a paper mismatch occurs, the message will remain on the display and the printer will remain off-line until you insert the correct paper.
- On: If a paper mismatch occurs, an error message will display. The printer will go offline for 30 seconds, then automatically clear the message and continue printing.

| Altitude Adj. | Values: Plain, High1, High2, High3 |

You can optimize print quality according to your altitude.

| Auto CR | Values: LF, LF+CR |

This item allows you to append the required carriage return to each line feed.

Refer to the following samples:

```
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>AA</td>
<td>AA</td>
</tr>
<tr>
<td>BB</td>
<td>BB</td>
</tr>
<tr>
<td>CC</td>
<td>CC</td>
</tr>
<tr>
<td>LF</td>
<td>LF+CR</td>
</tr>
</tbody>
</table>
```
Emulation menu

Use the Emulation menu to configure printer language emulation.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Timeout</td>
<td><strong>Values: 0 ~ 1800 sec</strong></td>
</tr>
<tr>
<td></td>
<td>You can set the length of time the printer waits before printing the last page of a print job that does not end with a command to print the page. The default is 15 sec. When a print time-out occurs, the printer prints the page in the print buffer.</td>
</tr>
<tr>
<td>Maintenance</td>
<td>This item allows you to maintain your printer.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Clean Drum</strong>: Cleans the OPC drum of the cartridge and produces a cleaning sheet with toner debris on it.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Clean Fuser</strong>: Cleans the fuser unit inside of the printer and produces a cleaning sheet with toner debris on it.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Supplies Life</strong>: This item allows you to check how many pages have printed and how much toner is left in the cartridge.</td>
</tr>
<tr>
<td>Clear Setting</td>
<td>This menu item allows you to restore the printer’s factory default settings.</td>
</tr>
</tbody>
</table>

**PCL**

This menu sets the PCL emulation configuration. You can set the font type, symbol type, lines per page, and point size.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Typeface</strong></td>
<td><strong>Values: PCL 1 ~ PCL 54</strong></td>
</tr>
<tr>
<td></td>
<td>You can select the standard font to be used in PCL emulation.</td>
</tr>
<tr>
<td></td>
<td>• PCL 1<del>PCL 7’s interval between letters is fixed, and PCL 8–PCL 45’s interval is proportional to the font type and point size. You can adjust the font size of PCL 1</del>PCL 7 using the <strong>Pitch</strong> item, and PCL 8–PCL 45 can do using <strong>Point Size</strong> item.</td>
</tr>
<tr>
<td></td>
<td>• PCL 46–PCL 54’s interval and point size are fixed.</td>
</tr>
<tr>
<td><strong>Symbol</strong></td>
<td><strong>Values: ROMAN8 ~ PCYRIL</strong></td>
</tr>
<tr>
<td></td>
<td>This item selects the symbol to be used in PCL emulation. The symbol is the group of numbers, marks, and special signs being used when printing letters. The default is <strong>PC8</strong>.</td>
</tr>
<tr>
<td><strong>Point Size</strong></td>
<td><strong>Values: 4.00 ~ 999.75 (0.25 unit)</strong></td>
</tr>
<tr>
<td></td>
<td>When you select one between PCL 8 and PCL 45 from the <strong>Typeface</strong> menu, you can determine the font size by setting the height of the characters in the font. The default is <strong>12.00</strong>.</td>
</tr>
<tr>
<td><strong>Courier</strong></td>
<td><strong>Values: Regular, Dark</strong></td>
</tr>
<tr>
<td></td>
<td>This item lets you select the version of Courier font to use.</td>
</tr>
<tr>
<td><strong>Pitch</strong></td>
<td><strong>Values: 0.44 ~ 99.99 (0.01 unit)</strong></td>
</tr>
<tr>
<td></td>
<td>When you select a font between PCL 1 and PCL 7 from the <strong>Typeface</strong> menu, you can determine the font size by setting the number of characters that will print in one horizontal inch of type. The default value, 10 is the best size.</td>
</tr>
<tr>
<td><strong>Lines</strong></td>
<td><strong>Values: 5 ~ 128 (1 unit)</strong></td>
</tr>
<tr>
<td></td>
<td>This item allows you to set vertical spacing from 5 to 128 lines for the default paper size. The lines may differ according to the paper size and printing orientation.</td>
</tr>
</tbody>
</table>
**PostScript**
This menu provides you with the Print PS Error menu item.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print PS Error</td>
<td>Values: On, Off&lt;br&gt;You can select whether or not your printer prints an error list when a PS error occurs.&lt;br&gt;  • Select On to print PS 3 emulation errors. If an error occurs, the job stops processing, the error message prints, and the printer flushes the job.&lt;br&gt;  • If this menu is set to Off, the job is flushed without an indication of the error.</td>
</tr>
</tbody>
</table>

**EPSON**
This menu sets the EPSON emulation configuration.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Values: SANSERIF, ROMAN&lt;br&gt;You can select the standard font that will be used in EPSON emulation.</td>
</tr>
<tr>
<td>Character Set</td>
<td>Values: USA, FRANCE, GERMANY, UK, DENMARK1, SWEDEN, ITALY, SPAIN1, JAPAN, NORWAY, DENMARK2, SPAIN2, LATIN&lt;br&gt;This item allows you to select a character set of the desired language.</td>
</tr>
<tr>
<td>Character Tab.</td>
<td>Values: ITALIC, PC437US, PC850&lt;br&gt;This item selects the character set.</td>
</tr>
<tr>
<td>Pitch</td>
<td>Values: 10, 12, 17.14, 20&lt;br&gt;You can determine the font size by setting the number of characters that will print in one horizontal inch of type.</td>
</tr>
<tr>
<td>LPI</td>
<td>Values: 6, 8&lt;br&gt;You can set the number of lines printed in one vertical inch.</td>
</tr>
<tr>
<td>Auto Wrap</td>
<td>Values: Off, On&lt;br&gt;This item determines whether or not the printer automatically performs line feed when the data overflows the printable area of the print material.</td>
</tr>
</tbody>
</table>

**Network menu**
This menu lets you configure the network interface installed in your printer. You can reset the network interface and print a configuration page.

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP</td>
<td>Values: DHCP, BOOTP, Static&lt;br&gt;This item allows you to manually set the TCP/IP addresses or receive the addresses from the network.&lt;br&gt;  • DHCP: The DHCP server assigns the IP address to you automatically.&lt;br&gt;  • BOOTP: The BOOTP server assigns the IP address to you automatically.&lt;br&gt;  • Static: You can enter IP address, subnet mask, and gateway manually.</td>
</tr>
<tr>
<td>EtherTalk</td>
<td>Values: Off, On&lt;br&gt;This item lets you select whether or not you use the EtherTalk protocol.&lt;br&gt;  • Off: You can disable the EtherTalk protocol.&lt;br&gt;  • On: You can enable the EtherTalk protocol.</td>
</tr>
<tr>
<td>Ethernet Speed</td>
<td>Values: Auto, 10M Half, 10M Full, 100M Half, 100M Full&lt;br&gt;This item allows you to select the ethernet speed.</td>
</tr>
<tr>
<td>Clear Setting</td>
<td>This item performs a simple reset and restores the factory default settings for the network configuration. This setting will only take effect after you have reset the printer.</td>
</tr>
<tr>
<td>Network Info.</td>
<td>This item prints a page showing the network parameters you set.</td>
</tr>
<tr>
<td>802.1x</td>
<td>Values: Off, On&lt;br&gt;This item is for connecting with an authentication server. If you need to connect this product to an authentication server, set this item On.</td>
</tr>
<tr>
<td>CentreWare IS</td>
<td>Values: Off, On&lt;br&gt;This item lets you select whether or not you use the embeded web server called CentreWare IS. If you turn this item Off, you cannot connect to the printer’s embeded web server.</td>
</tr>
</tbody>
</table>
**Printing a demo page**

Print a demo page to make sure that the printer is operating correctly.

1. Press **Menu** and then **OK** when **Information** appears.

2. Press the **Up/down arrow** buttons until **Demo Page** appears and press **OK**.

   A demo page prints out.

**Changing the display language**

To change the language that is displayed on the control panel, follow these steps:

1. Press **Menu** until **System Setup** appears on the bottom line of the display and press **OK**.

2. Press **OK** when **Language** appears.

3. Press the **Up/down arrow** buttons to select the language you want and press **OK**.

4. Press **Start/Stop** to return to Standby mode.

**Using toner save mode**

Toner save mode allows the printer to use less toner on each page. Activating this mode extends the life of your print cartridge and reduces your cost per page beyond what one would experience in the normal mode, but it reduces print quality.

There are two ways to enable this mode:

**Using the control panel button**

Press **Toner Save** on the control panel. The printer must be in Standby mode; the **Status** LED lights green and **Ready** is shown on the display.

- If the button backlight is on, the mode is enabled and the printer uses less toner to print a page.
- If the button backlight is off, the mode is disabled and the printer prints in normal mode.

**From the software application**

You can set toner save mode from the printer properties window on your printer driver. See the **Software Section**.
3 Software overview

This chapter gives you an overview of the software that comes with your printer. Further details about installing and using the software are explained in the Software Section.

This chapter includes:

- Supplied software
- Printer driver features
- System requirements

---

**Supplied software**

You must install the printer software using the supplied CD after you have set up your printer and connected it to your computer.

CD provides you with the following software:

<table>
<thead>
<tr>
<th>CD</th>
<th>Contents</th>
</tr>
</thead>
</table>
| Printer software CD       | Windows
|                           | • **Printer driver**: Use this driver to take full advantage of your printer’s features. |
|                           | • **Status Monitor**: Appears when printing errors occur.                |
|                           | • **Printer Settings Utility**: You can configure print settings.         |
|                           | • **PostScript Printer Description (PPD) file**: Use the PostScript driver to print documents with complex fonts and graphics in the PostScript language. |
|                           | • **SetIP**: Use this program to set your printer’s TCP/IP addresses.    |
|                           | • **User Guide** in PDF.                                                 |
| Linux                     | • **Printer driver**: Use this driver to run your machine from a Linux computer and print documents. |
| Mac OS                    | • **PostScript Printer Description (PPD) file**: Use this file to run your printer from a Macintosh computer and print documents. |
**Printer driver features**

Your printer drivers support the following standard features:
- Paper source selection
- Paper size, orientation and media type
- Number of copies

In addition, you can use various special printing features. The following table shows a general overview of features supported by your printer drivers:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Windows</th>
<th>Mac OS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PCL 6</td>
<td>PostScript</td>
</tr>
<tr>
<td>Print quality option</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Poster printing</td>
<td>O</td>
<td>X</td>
</tr>
<tr>
<td>Multiple pages per sheet (N-up)</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Fit to page printing</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Scale printing</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Different source for first page</td>
<td>O</td>
<td>X</td>
</tr>
<tr>
<td>Watermark</td>
<td>O</td>
<td>X</td>
</tr>
<tr>
<td>Overlay</td>
<td>O</td>
<td>X</td>
</tr>
</tbody>
</table>

**System requirements**

Before you begin, ensure that your system meets the following requirements:

**Windows**

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows 2000/XP/Vista/2003</td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>Windows 2000 Pentium II 400 MHz or higher</td>
<td>Pentium III 933 MHz</td>
</tr>
<tr>
<td></td>
<td>Windows XP/2003 Pentium III 933 MHz or higher</td>
<td>Pentium IV 1 GHz</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Pentium IV 3 GHz or higher</td>
<td>Pentium IV 3 GHz</td>
</tr>
<tr>
<td>RAM</td>
<td>Windows 2000 64 MB or more</td>
<td>128 MB</td>
</tr>
<tr>
<td></td>
<td>Windows XP/2003 128 MB or more</td>
<td>256 MB</td>
</tr>
<tr>
<td></td>
<td>Windows Vista 512 MB or more</td>
<td>1024 MB</td>
</tr>
<tr>
<td>Free disk space</td>
<td>Windows 2000 300 MB or more</td>
<td>1 GB</td>
</tr>
<tr>
<td></td>
<td>Windows XP/2003 1 GB or more</td>
<td>5 GB</td>
</tr>
<tr>
<td></td>
<td>Windows Vista 15 GB or more</td>
<td>15 GB</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>5.0 or higher</td>
<td></td>
</tr>
</tbody>
</table>

**Mac OS**

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Mac OS 10.3 ~ 10.5</td>
</tr>
<tr>
<td>CPU</td>
<td>Intel processor PowerPC G4/G5</td>
</tr>
<tr>
<td>RAM</td>
<td>Intel-based Mac 512 MB</td>
</tr>
<tr>
<td></td>
<td>Power-PC based Mac 128 MB</td>
</tr>
<tr>
<td>Free HDD space</td>
<td>1 GB</td>
</tr>
<tr>
<td>Connection</td>
<td>USB interface, Network interface</td>
</tr>
</tbody>
</table>

*Note*

Users who have administrator rights can install the software.
4 Network setup

This chapter gives you step-by-step instructions for setting up your printer for network connections.

This chapter includes:

- Introduction
- Supported operating systems
- Configuring TCP/IP
- Configuring EtherTalk
- Setting Ethernet speed
- Restoring the network configuration
- Printing a network configuration page
- Configuring 802.1x
- Configuring CentreWare IS

## Introduction

Once you have connected your printer to a network with an RJ-45 Ethernet cable, you can share the printer with other network users.

You need to set up the network protocols on the printer to use it as your network printer.

## Via network administration programs

You can configure your printer’s print server settings and manage the printer via the following programs that came with your printer:

- **CentreWare IS**: A web server embedded in your network printer, which allows you to remotely configure the printer settings and network parameters necessary for the printer to be connected to various network environments.
- **SetIP**: A utility program allowing you to select your network printer and manually configure the printer's TCP/IP addresses.

## Via the control panel

You can set up the following basic network parameters through the printer’s control panel:

- Configure TCP/IP
- Configure EtherTalk, 802.1x, and CentreWare IS

## Supported operating systems

The following table shows the network environments supported by the printer:

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network interface</td>
<td>10/100 Base-TX</td>
</tr>
<tr>
<td>Network operating system</td>
<td>Windows 2000/XP/Vista/2003</td>
</tr>
<tr>
<td></td>
<td>Mac OS 10.3 ~ 10.5</td>
</tr>
<tr>
<td></td>
<td>Various Linux OS</td>
</tr>
<tr>
<td>Network protocols</td>
<td>TCP/IP on Windows</td>
</tr>
<tr>
<td></td>
<td>EtherTalk</td>
</tr>
<tr>
<td></td>
<td>802.1x</td>
</tr>
<tr>
<td></td>
<td>CentreWare IS</td>
</tr>
<tr>
<td>Dynamic addressing server</td>
<td>DHCP, BOOTP</td>
</tr>
</tbody>
</table>

- DHCP: Dynamic Host Configuration Protocol
- BOOTP: Bootstrap Protocol
Configuring TCP/IP

Your printer can be set up with a variety of TCP/IP network information, such as an IP address, a subnet mask, a gateway, and DNS addresses. There are several ways in which your printer can be assigned a TCP/IP address, depending on your network.

- Static addressing: A TCP/IP address is assigned manually by the system administrator.
- Dynamic addressing via BOOTP/DHCP (default): A TCP/IP address is assigned automatically by the server.

**Note**
Before configuring TCP/IP, you need to set the network protocol to TCP/IP.

**Static addressing**

To enter a TCP/IP address from your printer’s control panel, take the following steps:

1. Press **Menu** until **Network** appears on the bottom line of the display and press **OK**.
2. Press **OK** when **TCP/IP** appears.
3. Press the **Up/down arrow** buttons until **Static** appears and press **OK**.
4. Press **OK** when **IP Address** appears.
5. Set the first byte between 0 and 255 using the **Up/down arrow** buttons and press **OK** to move to the next byte.
   - Repeat this to complete the address from the 1st byte to the 4th byte.
6. When you have finished, press **OK**.
7. Repeat step 5 and 6 to configure the other TCP/IP parameters: subnet mask and gateway address.
8. Press **Start/Stop** to return to Standby mode.

**Dynamic addressing (BOOTP/DHCP)**

To have a TCP/IP address assigned automatically by the server, take the following step:

1. Press **Menu** until **Network** appears on the bottom line of the display.
2. Press **OK** when **TCP/IP** appears.
3. Press the **Up/down arrow** buttons until **DHCP** or **BOOTP** appears and press **OK**.
4. Press **Start/Stop** to return to Standby mode.

---

Configuring EtherTalk

EtherTalk is AppleTalk used in an Ethernet network. This protocol is widely used in Macintosh network environments. To use EtherTalk, take the following steps:

1. Press **Menu** until **Network** appears on the bottom line of the display and press **OK**.
2. Press the **Up/down arrow** buttons until **EtherTalk** appears and press **OK**.
3. Press the **Up/down arrow** buttons until **On** appears and press **OK**.
4. Press **Start/Stop** to return to Standby mode.

Setting Ethernet speed

You can select the communication speed for Ethernet connections.

1. Press **Menu** until **Network** appears on the bottom line of the display and press **OK**.
2. Press the **Up/down arrow** buttons until **Ethernet Speed** appears and press **OK**.
3. Press the **Up/down arrow** buttons until the speed you want appears and press **OK**.
4. Press **Start/Stop** to return to Standby mode.

Restoring the network configuration

You can return the network configuration to its default settings.

1. Press **Menu** until **Network** appears on the bottom line of the display and press **OK**.
2. Press the **Up/down arrow** buttons until **Clear Setting** appears and press **OK**.
3. Press **OK** when **Yes** appears to restore the network configuration.
4. Power the printer off and back on.
Printing a network configuration page

The network configuration page shows how the network interface card on your printer is configured.

1 Press Menu until Network appears on the bottom line of the display and press OK.
2 Press the Up/down arrow buttons until Network Info. appears and press OK.
3 Press OK when Yes appears.
   The network configuration page prints out.

Configuring 802.1x

Your printer has 802.1x protocol on its network. 802.1x is a security standard for port based network access control. It secures your network against unauthorized access by requiring authentication before network access and data transmission are allowed. There are 3 mutually exclusive options for 802.1x authentication.

To use 802.1x, take the following steps:

1 Press Menu until Network appears on the bottom line of the display and press OK.
2 Press the Up/down arrow buttons until 802.1x appears and press OK.
3 Press the Up/down arrow buttons until On appears and press OK.
4 Press the Up/down arrow buttons until the desired authentication method appears.
   • EAP-MD5: EAP-MD5 (Extensible Authentication Protocol Message Digest algorithm 5) is a message hashing scheme between client and server to allow the transfer of user data in a secure fashion.
   • EAP-MSCAPv2: EAP-MSCHAP (Extensible Authentication Protocol Microsoft version of the Challenge-Handshake Authentication Protocol). MSCHAP v2 is a one-way encrypted password, mutual authentication process. MS-CHAPv2 uses different hashing/encryption algorithms to encode the UserID and passwords.
   • PEAP: PEAP (Protected EAP).
5 Enter user name and passcode using Up/down arrow button.
6 Press OK to save the selection.
7 Press Start/Stop to return to Standby mode.

Configuring CentreWare IS

Your printer can use CentreWare IS (Internet Services). To enable CentreWare IS, take the following steps:

1 Press Menu until Network appears on the bottom line of the display and press OK.
2 Press the Up/down arrow buttons until CentreWare IS appears and press OK.
3 Press the Up/down arrow buttons until On appears and press OK.
5 Loading print media

This chapter will help you understand types of paper you can use with your printer and how to properly load paper in the different paper trays for the best print quality.

This chapter includes:

• Selecting print media
• Loading paper
• Selecting an output location

Selecting print media

You can print on a variety of print media, such as plain paper, envelopes, labels, and transparencies. Always use print media that meet the guidelines for use with your printer. Print media that does not meet the guidelines outlined in this user's guide may cause the following problems:

• Poor print quality
• Increased paper jams
• Premature wear on the printer.

Properties, such as weight, composition, grain, and moisture content, are important factors that affect the printer’s performance and the output quality. When you choose print materials, consider the following:

• Desired outcome: The print media you choose should be appropriate for your project.
• Size: You can use any size media that fits easily within the paper adjusters of the paper tray.
• Weight: Your printer supports print media weights as follows:
  - 16 to 24 lb bond (60 to 90 g/m²) for the tray 1 and optional tray 2
  - 16 to 43 lb bond (60 to 163 g/m²) for the multi-purpose tray
  - 20 to 24 lb (75 to 90 g/m²) for the duplex printing
• Brightness: Some print media are whiter than others and produce sharper, more vibrant images.
• Surface smoothness: The smoothness of the print media affects how crisp the printing looks on the paper.

Notes

• Some print media may meet all of the guidelines in this section and still not produce satisfactory results. This may be the result of improper handling, unacceptable temperature and humidity levels, or other variables over which Xerox has no control.
• Before purchasing large quantities of print media, ensure that it meets the requirements specified in this user's guide.

Caution

Using print media that does not meet these specifications may cause problems, requiring repairs. Such repairs are not covered by Xerox's warranty or service agreements.
### Supported sizes of paper

<table>
<thead>
<tr>
<th>Type</th>
<th>Size</th>
<th>Dimensions</th>
<th>Weight&lt;sup&gt;a&lt;/sup&gt;</th>
<th>Capacity&lt;sup&gt;b&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Plain paper</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter</td>
<td>215.9 x 279 mm (8.5 x 11 inches)</td>
<td>60 to 90 g/m²</td>
<td>250 sheets of 80 g/m² (20 lb bond) paper for the tray</td>
</tr>
<tr>
<td></td>
<td>Legal</td>
<td>215.9 x 355.6 mm (8.5 x 14 inches)</td>
<td>60 to 163 g/m²</td>
<td>50 sheets for the multi-purpose tray</td>
</tr>
<tr>
<td></td>
<td>Oficio</td>
<td>216 x 330 mm (8.5 x 13 inches)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td>210 x 297 mm (8.27 x 11.69 inches)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>JIS B5</td>
<td>182 x 257 mm (7.18 x 10.12 inches)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ISO B5</td>
<td>176 x 250 mm (6.93 x 9.84 inches)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Executive</td>
<td>184.2 x 266.7 mm (7.25 x 10.5 inches)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A5</td>
<td>148.5 x 210 mm (5.85 x 8.27 inches)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A6</td>
<td>105 x 148.5 mm (4.13 x 5.85 inches)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Envelope</strong></td>
<td>Envelope Monarch</td>
<td>98.4 x 190.5 mm (3.88 x 7.5 inches)</td>
<td>75 to 90 g/m²</td>
<td>5 sheets of 75 g/m² (20 lb) in the multi-purpose tray</td>
</tr>
<tr>
<td></td>
<td>Envelope COM-10</td>
<td>105 x 241 mm (4.12 x 9.5 inches)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Envelope DL</td>
<td>110 x 220 mm (4.33 x 8.66 inches)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Envelope C5</td>
<td>162 x 229 mm (6.38 x 9.02 inches)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Envelope C6</td>
<td>114 x 162 mm (4.49 x 6.38 inches)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Transparency</strong></td>
<td>Letter, A4</td>
<td>Refer to the Plain paper section</td>
<td>138 to 146 g/m²</td>
<td>5 sheets of 75 g/m² (20 lb) in the multi-purpose tray</td>
</tr>
<tr>
<td><strong>Labels</strong></td>
<td>Letter, Legal, Folio, Oficio, A4, JIS B5, ISO B5, Executive, A5, A6</td>
<td>Refer to the Plain paper section</td>
<td>120 to 150 g/m² (32 to 40 lb)</td>
<td>5 sheets of 75 g/m² (20 lb) in the multi-purpose tray</td>
</tr>
<tr>
<td><strong>Card stock</strong></td>
<td>Letter, Legal, Folio, Oficio, A4, JIS B5, ISO B5, Executive, A5, A6</td>
<td>Refer to the Plain paper section</td>
<td>60 to 163 g/m² (16 to 43 lb)</td>
<td>5 sheets of 75 g/m² (20 lb) in the multi-purpose tray</td>
</tr>
<tr>
<td><strong>Minimum size (custom)</strong></td>
<td>76 x 127 mm (3 x 5 inches)</td>
<td>Refer to the Plain paper section</td>
<td>60 to 163 g/m² (16 to 43 lb bond)</td>
<td>5 sheets of 75 g/m² (20 lb) in the multi-purpose tray</td>
</tr>
<tr>
<td><strong>Maximum size (custom)</strong></td>
<td>215.9 x 356 mm (8.5 x 14 inches)</td>
<td>Refer to the Plain paper section</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<sup>a</sup> If media weight is over 24 lb (90 g/m²), use the multi-purpose tray.

<sup>b</sup> Maximum capacity may differ depending on media weight, thickness, and environmental conditions.

**Note**

For duplex printing, A4, Letter, Oficio, Legal, and Folio sizes are supported.
Guidelines for selecting and storing print media

When selecting or loading paper, envelopes, or other print materials, keep these guidelines in mind:

- Always use print media that conform with the specifications listed on page 5.3.
- Attempting to print on damp, curled, wrinkled, or torn paper can cause paper jams and poor print quality.
- For the best print quality, use only high quality copier grade paper specifically recommended for use in laser printers.
- Avoid using the following media types:
  - Paper with embossed lettering, perforations, or a texture that is too smooth or too rough
  - Erasable bond paper
  - Multi-paged paper
  - Synthetic paper and thermally reactive paper
  - Carbonless paper and Tracing paper.
- Use of these types of paper could result in paper jams, chemical smells, and damage to your printer.
- Store print media in its ream wrapper until you are ready to use it. Place cartons on pallets or shelves, not on the floor. Do not place heavy objects on top of the paper, whether it is packaged or unpackaged. Keep it away from moisture or other conditions that can cause it to wrinkle or curl.
- Store unused print media at temperatures between 15° C and 30° C (59° F to 86° F). The relative humidity should be between 10% and 70%.
- Store unused print media in a moisture-proof wrap, such as a plastic container or bag, to prevent dust and moisture from contaminating your paper.
- Load special media types one sheet at a time through the multi-purpose tray to avoid paper jams.
- To prevent print media, such as transparencies and label sheets, from sticking together, remove them as they print out.

Guidelines for special print media

<table>
<thead>
<tr>
<th>Media type</th>
<th>Guidelines</th>
</tr>
</thead>
</table>
| Envelopes  | • Successful printing on envelopes depends upon the quality of the envelopes. When selecting envelopes, consider the following factors:
  - Weight: The weight of the envelope paper should not exceed 90 g/m² (24 lb) or jamming may occur.
  - Construction: Prior to printing, envelopes should lie flat with less than 6 mm (0.25 inches) curl, and should not contain air.
  - Condition: Envelopes should not be wrinkled, nicked, or otherwise damaged.
  - Temperature: You should use envelopes that are compatible with the heat and pressure of the printer during operation.
• Use only well-constructed envelopes with sharp and well creased folds.
• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, coated lining, self-adhesive seals, or other synthetic materials.
• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope extends all the way to the corner of the envelope.
- Envelopes with a peel-off adhesive strip or with more than one flap that folds over to seal must use adhesives compatible with the printer’s fusing temperature of 200° C (392° F) for 0.1 second. The extra flaps and strips might cause wrinkling, creasing, or jams, and may even damage the fuser.
• For the best print quality, position margins no closer than 15 mm (0.6 inches) from the edges of the envelope.
• Avoid printing over the area where the envelope’s seams meet. |
## Media type  |  Guidelines
---|---
Transparencies  |  - To avoid damaging the printer, use only transparencies designed for use in laser printers.  
- Transparencies used in the printer must be able to withstand 200° C (392° F), the printer’s fusing temperature.  
- Place them on a flat surface after removing them from the printer.  
- Do not leave them in the paper tray for long periods of time. Dust and dirt may accumulate on them, resulting in spotty printing.  
- To avoid smudging caused by fingerprints, handle them carefully.  
- To avoid fading, do not expose printed transparencies to prolonged sunlight.  
- Ensure that transparencies are not wrinkled, curled, or have any torn edges.

Labels  |  - To avoid damaging the printer, use only labels designed for use in laser printers.  
- When selecting labels, consider the following factors:  
  - Adhesives: The adhesive material should be stable at 200° C (392° F), the printer’s fusing temperature.  
  - Arrangement: Only use labels with no exposed backing between them. Labels can peel off sheets that have spaces between the labels, causing serious jams.  
  - Curl: Prior to printing, labels must lie flat with no more than 13 mm (5 inches) of curl in any direction.  
  - Condition: Do not use labels with wrinkles, bubbles, or other indications of separation.  
- Make sure that there is no exposed adhesive material between labels. Exposed areas can cause labels to peel off during printing, which can cause paper jams. Exposed adhesive can also cause damage to printer components.  
- Do not run a sheet of labels through the printer more than once. The adhesive backing is designed for only a single pass through the printer.  
- Do not use labels that are separating from the backing sheet or are wrinkled, bubbled, or otherwise damaged.

Card stock or custom-sized materials  |  - Do not print on media smaller than 76 mm (3 inches) wide or 127 mm (5 inches) long.  
- In the software application, set margins at least 6.4 mm (0.25 inches) away from the edges of the material.

Preprinted paper  |  - Letterhead must be printed with heat-resistant ink that will not melt, vaporize, or release hazardous emissions when subjected to the printer’s fusing temperature of 205° C (400° F) for 0.1 second.  
- Letterhead ink must be non-flammable and should not adversely affect printer rollers.  
- Forms and letterhead should be sealed in a moisture-proof wrapping to prevent changes during storage.  
- Before you load preprinted paper, such as forms and letterhead, verify that the ink on the paper is dry. During the fusing process, wet ink can come off preprinted paper, reducing print quality.

---

### Loading paper

Load the print media you use for the majority of your print jobs in the tray 1. The tray 1 can hold a maximum of 250 sheets of 20 lb plain paper.

You can purchase an optional tray (tray 2) and attach it below the standard tray to load an additional 250 sheets of paper. For order information for an optional tray, see page 7.1.

The paper level indicator on the front of the tray 1 and the optional tray 2 shows the amount of paper currently left in the tray. When the tray is empty, the indicator bar appears at the bottom.
Using the tray 1 or the optional tray 2

Use the print material you use for the majority of your print jobs in the tray 1. The tray 1 can hold a maximum of 250 sheets of 80 g/m² paper.

You can purchase an optional tray 2 and attach it below the tray 1 to load an additional 250 sheets of paper.

To load paper, pull open the tray and load paper with the side to be printed on face down.

You can load letterhead paper with the design side face down. The top edge of the sheet with the logo should be placed at the front of the tray.

Notes
• If you experience problems with paper feed, place one sheet at a time in the multi-purpose tray.
• You can load previously printed paper. The printed side should be facing up with an uncurled edge at the front. If you experience problems with paper feed, turn the paper around. Note that the print quality is not guaranteed.

Changing the size of the paper in the tray 1

To load longer sizes of paper, such as Legal-sized paper, you need to adjust the paper guides to extend the paper tray.

1. Press and hold the guide lock, and slide the paper length guide to locate it in the correct paper size slot.

2. After inserting paper into the tray, adjust the support guide so that it lightly touches the paper stack.

3. Squeeze the paper width guides, as shown and slide them to the stack of paper until it lightly touches the side of the stack.
Notes

• Do not push the paper width guide far enough to cause the material to warp.
• If you do not adjust the paper width guide, it may cause paper jams.

Using the multi-purpose tray

The multi-purpose tray can hold special sizes and types of print material, such as transparencies, postcards, note cards, and envelopes. It is useful for single page printing on letterhead or colored paper.

To load paper in the multi-purpose tray:

1. Open the multi-purpose tray and unfold the multi-purpose tray extension, as shown.

2. If you are using paper, flex or fan the edge of the paper stack to separate the pages before loading.

For transparencies, hold them by the edges and avoid touching the print side. Oils from your fingers can cause print quality problems.

3. Load the paper with the side to be printed on facing up.

Depending on the media type you are using, keep the following loading guidelines:

• Envelopes: Flap side down and with the stamp area on the top left side. If you need to do the printing job with a wrinkled envelopes, open the rear cover, (see page 5.8.) Push the pressure lever on each side down.

• Transparencies: Print side up and the top with the adhesive strip entering the printer first.

• Labels: Print side up and top short edge entering the printer first.

• Preprinted paper: Design side up with the top edge toward the printer.

• Card stock: Print side up and the short edge entering the printer first.

• Previously printed paper: Previously printed side down with an uncurled edge toward the printer.

Note

Make sure that you have not loaded too much print material. The print material buckles if you load a stack that is too deep or if you push it in too far.
Caution
When you print on special material like envelopes, labels, transparencies, or cards, the output location should be the rear cover. Open the rear cover to use it. See page 5.8.

4 Squeeze the multi-purpose tray paper width guides and adjust them to the width of the paper. Do not force too much, or the paper will be bent, which will result in a paper jam or skew.

5 When you print a document, set the paper source and type in the software application. See the Software Section.

   For information about setting the paper source and type on the control panel, see page 2.3.

6 After printing, fold the multi-purpose tray extension and close the multi-purpose tray.

Tips on using the multi-purpose tray
• Load only one size of print media at a time in the multi-purpose tray.
• To prevent paper jams, do not add paper when there is still paper in the multi-purpose tray. This also applies to other types of print media.
• Print media should be loaded face up with the top edge going into the multi-purpose tray first and be placed in the center of the tray.
• Always load only the print media specified in page 5.1 to avoid paper jams and print quality problems.
• Flatten any curl on postcards, envelopes, and labels before loading them into the multi-purpose tray.
• When you print on 76 mm x 127 mm (3 x 5 inches) sized media on the multi-purpose tray, open the rear cover for straight paper path to avoid paper jams.
• Make sure to open the rear cover when you print on transparencies. If not, they may tear while exiting the printer.

Using manual feed mode
You can manually load a sheet of print material in the multi-purpose tray if you select Manual Feeder in the Source option from the Paper tab when you change print settings to print a document. See the Software Section. Manually loading paper can be helpful when you want to check the print quality after each page is printed.

This loading procedure is almost the same as the procedure for loading in the multi-purpose tray, except you load paper sheet-by-sheet in the tray, send print data to print the first page, and press OK on the control panel to print each following page.

1 Load the paper with the side to be printed on facing up.

2 Squeeze the multi-purpose tray paper width guides and adjust them to the width of the paper. Do not force too much, or the paper will be bent, which will result in a paper jam or skew.

3 When you print a document, set the paper source to Manual Feeder and select the appropriate paper size and type in the software application. See the Software Section.

4 Print a document.

   The display shows a message prompting you to load paper and press OK.

5 Press Stop.

   The printer picks up the print material and prints. After one page is printed, the message appears again.

   Note
   If you do not press the button, after a pause the printer will automatically pick the print material.

6 Insert the next sheet into the multi-purpose tray and press Stop.

   Repeat this step for every page to be printed.
Selecting an output location

The printer has two output locations; the rear cover (face up) and the output tray (face down).

The printer sends output to the output tray by default. To use the output tray, make sure that the rear cover is closed.

Notes
- If paper coming out of the output tray has problems, such as excessive curl, try printing to the rear cover.
- To avoid paper jams, do not open or close the rear cover while the printer is printing.

Printing to the rear cover (Face up)

Using the rear cover, paper comes out of the printer face up.

Printing from the multi-purpose tray to the rear cover provides a straight paper path. Using the rear cover might improve the output quality with special print media.

To use the rear cover, open it by pulling down.

Printing to the output tray (Face down)

The output tray collects paper face down, in the order in which the sheets were printed. The tray should be used for most print jobs.

Caution
The fuser area inside the rear cover of your printer becomes very hot when in use. Take care when you access this area.
6 Basic printing

This chapter explains common printing tasks.
This chapter includes:
• Printing a document
• Canceling a print job

---

**Printing a document**

This printer allows you to print from various Windows, Mac OS applications. The exact steps for printing a document may vary depending on the application you use.

For details about printing, see the Software Section.

---

**Canceling a print job**

If the print job is waiting in a print queue or print spooler, such as the printer group in Windows, delete the job as follows:

1. Click the Windows Start button.
2. For Windows 2000, select Settings and then Printers.
   For Windows XP/2003, select Printers and Faxes.
   For Windows Vista, select Control Panel > Hardware and Sound > Printers.
3. Double-click the Xerox Phaser 3435 PCL 6 or Xerox Phaser 3435 PS icon.

**Note**

You can access this window simply by double-clicking the printer icon at the bottom right corner of the Windows desktop.

You can also cancel the current job by pressing Start/Stop on the control panel of your printer.
7 Ordering supplies and accessories

This chapter provides information on purchasing print cartridges and accessories available for your printer.

- Print cartridges
- Accessories
- How to purchase

### Print cartridges

When the toner runs out, you can order the following types of print cartridges for your printer:

<table>
<thead>
<tr>
<th>Type</th>
<th>Yielda</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard yield</td>
<td>4,000 pages</td>
<td>106R01414</td>
</tr>
<tr>
<td>High yield</td>
<td>10,000 pages</td>
<td>106R01415</td>
</tr>
</tbody>
</table>

a. Declared yield value in accordance with ISO/IEC 19752.

### Accessories

You can purchase and install accessories to enhance your printer’s performance and capacity.

The following accessories are available for your printer:

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Description</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional tray</td>
<td>If you are experiencing frequent paper supply problems, you can attach an additional 250 sheet tray. You can print documents on various sizes and types of print materials.</td>
<td>097N01539</td>
</tr>
</tbody>
</table>
| Memory DIMM  | Extends your printer’s memory capacity.                                                                                                    | 097S03132: 32 MB  
                        |                                                                                                                                            | 097S03136: 128 MB  
                        |                                                                                                                                            | 097S03761: 256 MB |

How to purchase

To order Xerox-authorized supplies or accessories, contact your local Xerox dealer or the retailer where you purchased your printer, or visit [www.xerox.com/office/support](http://www.xerox.com/office/support) and select your country/region for information on calling for technical support.
# 8 Maintenance

This chapter provides information for maintaining your printer and the print cartridge, as well as suggestions for high-quality and economical printing.

This chapter includes:
- Printing information page
- Cleaning the printer
- Maintaining the print cartridge
- Maintenance parts

## Printing information page

From the printer’s control panel, you can print pages that give detailed information about the printer. They can be help you maintain your printer.

1. Press Menu until Information appears on the bottom line of the display and press OK.
2. Press the scroll buttons until the information page you want appears and press OK.

A page prints out.

## Cleaning the printer

During the printing process, paper, toner, and dust particles can accumulate inside the printer. This buildup can cause print quality problems, such as toner specks or smearing. Your printer has a cleaning mode that can correct and prevent these types of problems.

### Cleaning the inside of the printer

There are two methods to clean the inside of the printer:
- Clean the inside manually.
- Print a cleaning sheet, which can be done from the control panel.

#### Cleaning the inside of the printer manually

1. Turn the printer off and unplug the power cord. Wait for the printer to cool down.
2. Open the front cover and pull the print cartridge out. Set it on a clean flat surface.
3. With a dry lint-free cloth, wipe away any dust and spilled toner from the print cartridge area and the print cartridge cavity.

### Cautions

- To prevent damage to the print cartridge, do not expose it to light for more than a few minutes. Cover it with a piece of paper, if necessary.
- Do not touch the green surface underside of the print cartridge. Use the handle on the cartridge to avoid touching this area.

#### Cleaning the outside of the printer

Clean the cabinet of the printer with a soft, lint-free cloth. You can dampen the cloth slightly with water, but be careful not to let any water drip onto or into the printer.

**Caution**

If your machine or its surrounding is contaminated with toner, we recommend you to use a cloth or tissue dampened with water to clean it. Toner blown into the air by a vacuum cleaner maybe harmful.

**Caution**

Cleaning the cabinet of the printer with cleaning materials containing large amounts of alcohol, solvents, or other strong substances can discolor or crack the cabinet.

**Caution**

While cleaning the inside of the printer, be careful not to touch the transfer roller, located underneath the print cartridge. Oil from your fingers can cause print scan quality problems.
4. Locate the long strip of glass (LSU) inside the top of the cartridge compartment, and gently swab the glass with a cotton swab checking to see if dirt turns the cotton black.

5. Reinsert the print cartridge and close the front cover.

6. Plug in the power cord and turn the printer on.

**Printing a cleaning sheet**

If you are experiencing blurred, faded, or smeared printouts, you can clear the problem by printing a cleaning sheet, provided by your printer. You can print:

- OPC Cleaning sheet: cleans the OPC drum of the print cartridge.
- Fuser Cleaning sheet: cleans the fuser unit inside the printer.

This process will produce a page with toner debris, which should be discarded.

1. Make sure that the printer is turned on with paper loaded in the tray.

2. Press Menu until System Setup appears on the bottom line of the display and press OK.

3. Press the scroll buttons until Maintenance appears and press OK.

4. When Clean Drum appears, press OK.
   Or, press the scroll buttons until Clean Drum or Clean Fuser appears and press OK.

   Your printer automatically picks up a sheet of paper from the tray and prints out a cleaning sheet with dust or toner particles on it.

   • To prevent damage to the print cartridge, do not expose it to light for more than a few minute.

   **Expected cartridge life**

   The print cartridge yield depends on the amount of toner that print jobs require. Average yield for a new print cartridge is either 10,000 or 4000 standard pages in accordance with the ISO/IEC 19752 standard. (Average yield for the original print cartridge supplied with the machine is 4,000 standard pages.) The actual number may also be different depending on the print density of the pages you print on, and the number of pages may be affected by operating environment, printing interval, media type, and media size. If you print a lot of graphics, you may need to change the cartridge more often.

**Saving Toner**

To save toner, press Toner Save on the control panel. The button backlight turns on.

Using this feature extends the life of the print cartridge and reduce your cost per page, but it also reduces print quality.

**Checking the remaining toner**

You can check the level of toner left in the cartridge.

If you are having print quality problems, this can help you determine if the problem is caused by low toner.

1. Press Menu until System Setup appears on the bottom line of the display press OK.

2. Press the scroll buttons until Maintenance appears and press OK.

3. Press the scroll buttons until Supplies Life appears and press OK.

4. Press the scroll buttons to access Toner Remains and press OK.

   The display shows the percentage of the remaining toner.

   **Note**

   While the following messages are appearing on the display, the sub-menu(s) under Supplies Life can be changed:

   - Invalid Toner, NonGenuine Toner, Replace Toner, Toner Exhausted

---

**Maintaining the print cartridge**

**Print cartridge storage**

To get the most from the print cartridge, keep the following guidelines in mind:

- Do not remove the print cartridge from its package until ready for use.
- Do not refill the print cartridge. The printer warranty does not cover damage caused by using a refilled cartridge.
- Store print cartridge in the same environment as the printer.
Redistributing print cartridge

When the print cartridge is near the end of its life:

- White streaks or light printing occurs.
- **Toner Low** appears on the display.
- The Status Monitor program window appears on the computer telling you that the toner level is low.
- The **Status** LED blinks red.

If this happens, you can temporarily reestablish print quality by redistributing the remaining toner in the cartridge. In some cases, white streaks or light printing will still occur even after you have redistributed the toner.

1. Open the **front cover**.
2. Pull the print cartridge out.
3. Thoroughly roll the cartridge 5 or 6 times to distribute the toner evenly inside the cartridge.

**Cautions**

- Avoid reaching too far into the printer. The fusing area may be hot.
- To prevent damage to the print cartridge, do not expose it to light for more than a few minutes. Cover it with a piece of paper, if necessary.
- Do not touch the green surface underside of the print cartridge. Use the handle on the cartridge to avoid touching this area.

4. Hold the print cartridge by the handle and slowly insert the cartridge into the opening in the printer.
5. Tabs on the sides of the cartridge and corresponding grooves within the printer will guide the cartridge into the correct position until it locks into place completely.
6. Close the **front cover**. Make sure that the cover is securely closed.

Replacing the print cartridge

When the print cartridge is completely empty:

- **Toner Low Replace Toner** appears on the display.
- The **Smart Panel** program window appears on the computer telling you that the print cartridge is empty.
- The **Status** LED blinks red.

At this stage, the print cartridge needs to be replaced. For order information for print cartridges, see page 7.1.

1. Open the **front cover**.
2. Pull the print cartridge out.

**Note**

If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water. Hot water sets toner into fabric.
3 Remove the new print cartridge from its bag.

Caution
Do not use sharp objects, such as a knife or scissors, to open the print cartridge package. They might scratch the drum of the cartridge.

4 Remove the packing tape and roll the cartridge 5 or 6 items to distribute the toner.

Thoroughly roll the cartridge to assure maximum copies per cartridge. Save the box and the plastic bag for shipping.

Cautions
• If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water. Hot water sets toner into fabric.
• To prevent damage to the print cartridge, do not expose it to light for more than a few minutes. Cover it with a piece of paper, if necessary.
• Do not touch the green surface underside of the print cartridge. Use the handle on the cartridge to avoid touching this area.

5 Hold the print cartridge by the handle and slowly insert the cartridge into the opening in the printer.

6 Tabs on the sides of the cartridge and corresponding grooves within the printer will guide the cartridge into the correct position until it locks into place completely.

Clearing the Toner Low Replace Toner message
When the Toner Low Replace Toner message appears you can configure not to see this message again to not disturb you.

1 Press Menu until System Setup appears on the bottom line of the display and press OK.

2 Press the scroll buttons until Maintenance appears and press OK.

3 Press the scroll buttons until CLR Empty MSG. appears and press OK.

4 Select On and press OK.

5 Now the Toner Low Replace Toner message does not appear but the Replace Toner message will remain for reminding you that the new cartridge needs to be installed for quality.

Caution
Once you have selected On, this setting will be permanently written to the memory of the print cartridge, and this menu will be disappeared from the Maintenance menu.

Maintenance parts
To avoid print quality and paper feed problems resulting from worn parts and to maintain your printer in top working condition the following items will need to be replaced at the specified number of pages or when the life span of each item has expired.

<table>
<thead>
<tr>
<th>Items</th>
<th>Yield (Average)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer roller</td>
<td>70,000 page</td>
</tr>
<tr>
<td>Pick-up roller</td>
<td>150,000 page</td>
</tr>
<tr>
<td>Fuser unit</td>
<td>80,000 page</td>
</tr>
</tbody>
</table>

Xerox highly recommends that an authorized service provider, dealer or the retailer where you bought printer performs this maintenance activity. The warranty does not cover the replacement of the maintenance parts after their lifespan.

7 Close the front cover. Make sure that the cover is securely closed.
This chapter provides helpful information for what to do if you encounter an error while using your printer.

This chapter includes:

- Clearing paper jams
- Troubleshooting checklist
- Understanding display messages
- Print cartridge-related messages
- Solving general printing problems
- Solving print quality problems
- Common Windows problems
- Common PostScript problems
- Common Linux problems
- Common Macintosh problems

9 Troubleshooting

Clearing paper jams

When removing paper that is jammed in the printer, if possible always pull the paper in the direction that it normally moves so as not to damage internal components. Always pull firmly and evenly; do not jerk the paper. If the paper tears, ensure that all fragments of paper are removed; otherwise a jam will occur again.

When a paper jam occurs, the Status LED lights red. Open and close the front cover. The jammed paper automatically exit the printer.

If the paper does not exit, check the display on the control panel. The message indicating the corresponding location of the paper jam appears. Refer to the table below to locate the paper jam and to clear it:

<table>
<thead>
<tr>
<th>Message</th>
<th>Location of Jam</th>
<th>Go To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Jam 0 Open/Close Door</td>
<td>In the paper feed area</td>
<td>below</td>
</tr>
<tr>
<td></td>
<td>(tray 1, optional tray 2, multi-purpose tray)</td>
<td></td>
</tr>
<tr>
<td>Paper Jam 1 Open/Close Door</td>
<td>Around the print cartridge</td>
<td>page 9.3</td>
</tr>
<tr>
<td>Paper Jam 2 Check Inside</td>
<td>In the paper exit area</td>
<td>page 9.3</td>
</tr>
<tr>
<td>Duplex Jam 0 Check Inside</td>
<td>In the duplex area</td>
<td>page 9.4</td>
</tr>
<tr>
<td>Duplex Jam 1 Open/Close Door</td>
<td>In the duplex area</td>
<td>page 9.5</td>
</tr>
</tbody>
</table>

In the paper feed area

In the tray 1

1. Pull the tray 1 open.
2. Remove the jammed paper by gently pulling it straight out. Make sure that all of the paper is properly aligned in the tray 1.

If the paper does not move when you pull, or if you do not see the paper in this area, check the fuser area around the print cartridge. See page 9.3.

3. Insert the tray 1 into the printer until it snaps into place. Printing automatically resumes.

**In the optional tray 2**

1. Pull the optional tray 2 open.
2. Remove the jammed paper from the printer.

3. Pull tray 1 half-way out.

4. Pull the paper straight up and out.

5. Insert the trays back into the printer. Printing automatically resumes.

**In the multi-purpose tray**

1. If the paper is not feeding properly, pull the paper out of the printer.

2. Open and close the front cover to resume printing.

If the paper does not move when you pull, or if you do not see the paper in this area, stop and go to step 3.
**Around the print cartridge**

**Note**
The fuser area is hot. Take care when removing paper from the printer.

1. Open the front cover and pull the print cartridge out.

2. Remove the jammed paper by gently pulling it straight out.

3. Replace the print cartridge and close the front cover. Printing automatically resumes.

**In the paper exit area**

1. Open and close the front cover. The jammed paper is automatically ejected from the printer.

2. Gently pull the paper out of the output tray.

If you do not see the jammed paper or if there is any resistance when you pull, stop and go to the next step.

3. Open the rear cover.

4. If you see the jammed paper, push the pressure lever on each side down and remove the paper. Return the pressure lever to its original position and skip the step 10.

If you still do not see the paper, go to the next step.
5 Release the blue strap, the rear cover stopper, and fully open the rear cover, as shown.

6 Unfold the duplex guide fully.

7 While pushing the fuser lever to the right, open the fuser door.

8 Pull the jammed paper out. If the jammed paper does not move when you pull, push the pressure lever on each side down to loosen the paper, and then remove it.

9 Return the lever, door, stopper, and guide to their original position.

10 Close the rear cover. Printing automatically resumes.

In the duplex unit area

If the duplex unit is not inserted correctly, paper jam may occur. Make sure that the duplex unit is inserted correctly.

Duplex jam 0

1 Pull the duplex unit out of the printer.
2 Remove the jammed paper from the duplex unit.

If the paper does not come out with the duplex unit, remove the paper from the bottom of the printer.

3 Pull the jammed paper out.

Duplex jam 1
1 Open the rear cover.
2 Unfold the duplex guide fully.

Tips for avoiding paper jams
By selecting the correct media types, most paper jams can be avoided. When a paper jam occurs, follow the steps outlined on page 9.1.

- Follow the procedures on page 5.5. Ensure that the adjustable guides are positioned correctly.
- Do not overload the tray. Ensure that the paper level is below the paper capacity mark on the inside wall of the tray.
- Do not remove paper from the tray while your printer is printing.
- Flex, fan, and straighten paper before loading.
- Do not use creased, damp, or highly curled paper.
- Do not mix paper types in a tray.
- Use only recommended print media. See page 5.1.
- Ensure that the recommended print side of print media is facing down in the tray, or facing up in the multi-purpose tray.
- If paper jams occur frequently when you print on A5-sized paper:

   Load the paper into the tray with the long edge facing the front of the tray.

In the printer properties window, set the page orientation to be rotated 90 degrees. See the Software Section.
Troubleshooting checklist

If the printer is not working properly, consult the following checklist. If the printer does not pass a step, follow the corresponding troubleshooting suggestions.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make sure that the Status LED on the control panel lights green and <strong>Ready</strong> is shown on the display.</td>
<td>• If the Status LED is off, check the power cord connection. Check the power switch. Check the power source by plugging the power cord into another outlet. • If the Status LED lights red, check the display message. See page 9.6.</td>
</tr>
<tr>
<td>Print a demo page to verify that the printer is feeding paper correctly. See page 2.7.</td>
<td>• If a demo page does not print, check the paper supply in the tray. • If the paper jams in the printer, see page 9.1. • If an error message appears on the display, see page 9.6.</td>
</tr>
<tr>
<td>Check the demo page to see if it printed correctly.</td>
<td>If there is a print quality problem, see page 9.11.</td>
</tr>
<tr>
<td>Print a short document from a software application to verify that the computer and printer are connected and are communicating correctly.</td>
<td>• If the page does not print, check the cable connection between the printer and the computer. • Check the print queue or print spooler to see if the printer has been paused. • Check the software application to ensure that you are using the proper printer driver and communication port. If the page is interrupted during printing, see page 9.9.</td>
</tr>
</tbody>
</table>

Understanding display messages

Messages appear on the Smart Panel program window or the control panel display to indicate the printer's status or errors. Refer to the tables below to understand the messages' meaning and correct the problem if necessary. Messages and their meanings are listed in alphabetical order.

**Note**

When you call for service, it is very convenient to tell the service representative the display message.

<table>
<thead>
<tr>
<th>Message</th>
<th>Meaning</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Door Open</td>
<td>The front cover or rear cover is not securely latched.</td>
<td>Close the cover until it locks into place.</td>
</tr>
<tr>
<td>Duplex Jam 0 Check Inside</td>
<td>Paper has jammed during duplex printing.</td>
<td>Clear the jam. See page 9.4.</td>
</tr>
<tr>
<td>Duplex Jam 1 Open/Close Door</td>
<td>Paper has jammed during duplex printing.</td>
<td>Clear the jam. See page 9.5.</td>
</tr>
<tr>
<td>Fuser Door Open</td>
<td>The fuser door is not securely latched.</td>
<td>Open the rear cover and close the fuser door until it locks into place. For the location of the fuser door, see page 9.4.</td>
</tr>
<tr>
<td>IP Conflict</td>
<td>The network IP address you have set is being used by someone else.</td>
<td>Check the IP address and reset it if necessary. See Software section.</td>
</tr>
<tr>
<td>Load Manually Press Stop Key</td>
<td>The multi-purpose tray is empty in manual feed mode.</td>
<td>Load a sheet of print material and press Stop.</td>
</tr>
<tr>
<td>Low Heat Error Cycle Power</td>
<td>There is a problem in the fuser unit.</td>
<td>Unplug the power cord and plug it back in. If the problem persists, please call for service.</td>
</tr>
<tr>
<td>LSU Hsync Error Cycle Power</td>
<td>A problem has occurred in the LSU (Laser Scanning Unit).</td>
<td>Unplug the power cord and plug it back in. If the problem persists, please call for service.</td>
</tr>
<tr>
<td>Message</td>
<td>Meaning</td>
<td>Suggested solutions</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LSU Motor Error</td>
<td>A problem has occurred in the LSU (Laser Scanning Unit).</td>
<td>Unplug the <strong>power cord</strong> and plug it back in. If the problem persists, please call for service.</td>
</tr>
<tr>
<td>Cycle Power</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Main Motor Locked</td>
<td>There is a problem in the main motor.</td>
<td>Open and then close the <strong>front cover</strong>.</td>
</tr>
<tr>
<td>Open Heat Error</td>
<td>There is a problem in the fuser unit.</td>
<td>Unplug the <strong>power cord</strong> and plug it back in. If the problem persists, please call for service.</td>
</tr>
<tr>
<td>Cycle Power</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Over Heat Error</td>
<td>There is a problem in the fuser unit.</td>
<td>Unplug the <strong>power cord</strong> and plug it back in. If the problem persists, please call for service.</td>
</tr>
<tr>
<td>Cycle Power</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper Jam 0</td>
<td>Paper has jammed in the feeding area of the tray.</td>
<td>Clear the jam. See page 9.1 and page 9.1.</td>
</tr>
<tr>
<td>Open/Close Door</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper Jam 1</td>
<td>Paper has jammed in the fuser area.</td>
<td>Clear the jam. See page 9.3.</td>
</tr>
<tr>
<td>Open/Close Door</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper Jam 2</td>
<td>Paper has jammed in the paper exit area.</td>
<td>Clear the jam. See page 9.3.</td>
</tr>
<tr>
<td>Check Inside</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Printing...</td>
<td>The printer is printing jobs using the displayed language.</td>
<td>Complete your printing.</td>
</tr>
<tr>
<td>Ready</td>
<td>The printer is on-line and ready to printer.</td>
<td>Use your printer.</td>
</tr>
<tr>
<td>Self Diagnostic LSU</td>
<td>The LSU (Laser Scanning Unit) in your printer is checking some problems detected.</td>
<td>Please wait a few minutes.</td>
</tr>
<tr>
<td>Temperature</td>
<td>The engine in your printer is checking some problems detected.</td>
<td>Please wait a few minutes.</td>
</tr>
<tr>
<td>Sleeping...</td>
<td>The printer is on power save mode.</td>
<td>When data is received, it switches to on-line automatically.</td>
</tr>
<tr>
<td>Tray 1 Paper Empty</td>
<td>There is no paper in the tray 1.</td>
<td>Load paper in the <strong>tray 1</strong>.</td>
</tr>
<tr>
<td>Tray 2 Paper Empty</td>
<td>There is no paper in the optional tray 2.</td>
<td>Load paper in the <strong>optional tray 2</strong>.</td>
</tr>
</tbody>
</table>

**Message**

- LSU Motor Error
- Main Motor Locked
- Open Heat Error
- Over Heat Error
- Paper Jam 0
- Paper Jam 1
- Paper Jam 2
- Printing...
- Ready
- Self Diagnostic LSU
- Self Diagnostic Temperature
- Sleeping...

**Meaning**

- Tray 1 Paper Empty
- Tray 2 Paper Empty

**Suggested solutions**

- Load paper in the **tray 1**. See page 5.5.
- Load paper in the **optional tray 2**. See page 5.5.
## Print cartridge-related messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Meaning</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Toner</td>
<td>The print cartridge is installed improperly, or not installed.</td>
<td>Reinstall the print cartridge two or three times. If the problem persists, the print cartridge is not being detected. Please contact the service representatives.</td>
</tr>
<tr>
<td>Invalid Toner</td>
<td>The print cartridge you have installed is not for your printer.</td>
<td>Install a Xerox-genuine print cartridge, designed for your printer.</td>
</tr>
<tr>
<td>Toner Low</td>
<td>The print cartridge is almost empty.</td>
<td>Take out the print cartridge and thoroughly shake it. By doing this, you can temporarily reestablish printing operations.</td>
</tr>
<tr>
<td>NonGenuine Toner Stop</td>
<td>The print cartridge installed is not a Xerox-genuine cartridge.</td>
<td>You can select either Stop or Continue. If you do not select any, the printer will work as Stop is selected. If you select Stop, you cannot print until the Xerox-genuine cartridge is installed. However, you can still print any kind of reports. If you select Continue, you can keep printing but the quality cannot be guaranteed, and the product support is no longer provided. If you want to change the selection, turn the printer off and on to have this message appear again, and then re-select Stop or Continue.</td>
</tr>
<tr>
<td>NonGenuine Toner</td>
<td>The print cartridge installed is not a Xerox-genuine cartridge.</td>
<td>This message appears when you selected Stop at the NonGenuine Toner prompt. Install the Xerox-genuine print cartridge.</td>
</tr>
<tr>
<td>NonGenuine Toner</td>
<td>The print cartridge installed is not a Xerox-genuine cartridge.</td>
<td>This message appears when you selected Continue at the NonGenuine Toner prompt. Install the Xerox-genuine print cartridge.</td>
</tr>
<tr>
<td>Toner Low Replace Toner</td>
<td>The toner in the cartridge has run out.</td>
<td>Install a new Xerox-genuine print cartridge. You can keep printing but the quality cannot be guaranteed, and the product support is no longer provided. You can configure not to see the Toner Low Replace Toner message. See page 8.4.</td>
</tr>
<tr>
<td>Replace Toner</td>
<td>The toner in the cartridge has run out.</td>
<td>This message appears when you turned off the Toner Low Replace Toner message. See page 8.4. Install a new Xerox-genuine print cartridge. You can keep printing but the quality cannot be guaranteed, and the product support is no longer provided.</td>
</tr>
<tr>
<td>Toner Exhausted</td>
<td>The lifespan of the print cartridge is reached.</td>
<td>This message appears when the toner is completely empty and your machine stops printing. Install the Xerox-genuine print cartridge.</td>
</tr>
</tbody>
</table>
# Troubleshooting

## Solving general printing problems

For problems with the operation of your printer, refer to the table for suggested solutions.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Possible cause</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer does not print.</td>
<td>The printer is not receiving power.</td>
<td>Check the power cord connections. Check the power switch and the power source.</td>
</tr>
<tr>
<td></td>
<td>The printer is not selected as the default printer.</td>
<td>Select Xerox Phaser 3435 as your default printer.</td>
</tr>
<tr>
<td></td>
<td>The printer cover is not closed.</td>
<td>Close the printer cover.</td>
</tr>
<tr>
<td></td>
<td>Paper is jammed.</td>
<td>Clear the paper jam. See page 9.1.</td>
</tr>
<tr>
<td></td>
<td>No paper is loaded.</td>
<td>Load paper. See page 5.4.</td>
</tr>
<tr>
<td></td>
<td>The print cartridge is not installed.</td>
<td>Install the print cartridge.</td>
</tr>
<tr>
<td></td>
<td>The printer may be in manual feed mode and out of paper.</td>
<td>Check the display message, add paper to the multi-purpose tray, and press OK on the printer’s control panel.</td>
</tr>
<tr>
<td></td>
<td>The connection cable between the computer and the printer is not connected properly.</td>
<td>Disconnect the printer cable and reconnect it.</td>
</tr>
<tr>
<td></td>
<td>The connection cable between the computer and the printer is defective.</td>
<td>If possible, attach the cable to another computer that is working properly and try to print a document. You can also try using a different printer cable.</td>
</tr>
<tr>
<td></td>
<td>The port setting is incorrect.</td>
<td>Check the Windows printer setting to make sure that the print job is sent to the correct port. If the computer has more than one port, make sure that the printer is attached to the correct one.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Condition</th>
<th>Possible cause</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer does not print. (Continued)</td>
<td>The printer may be configured incorrectly.</td>
<td>Check the printer properties to ensure that all of the print settings are correct.</td>
</tr>
<tr>
<td></td>
<td>The printer driver may be incorrectly installed.</td>
<td>Reinstall the printer driver; See the Software Section. Try printing a test page.</td>
</tr>
<tr>
<td></td>
<td>The printer is malfunctioning.</td>
<td>Check the display message on the control panel to determine if the printer is indicating a system error.</td>
</tr>
<tr>
<td>Printer selects print materials from the wrong paper source.</td>
<td>The paper source selection in the printer properties may be incorrect.</td>
<td>For many software applications, the paper source selection is found under the Paper tab within the printer properties. Select the correct paper source. See the Software Section.</td>
</tr>
<tr>
<td>Paper does not feed into the printer.</td>
<td>Paper has not been loaded correctly.</td>
<td>Remove paper from the tray and reload it correctly. Check that the paper size guides are set correctly.</td>
</tr>
<tr>
<td></td>
<td>There is too much paper in the tray.</td>
<td>Remove excess paper from the tray.</td>
</tr>
<tr>
<td></td>
<td>The paper is too thick.</td>
<td>Use only paper that meets printer specifications.</td>
</tr>
<tr>
<td>Print job is extremely slow.</td>
<td>The job may be very complex.</td>
<td>Reduce the complexity of the page(s) or try adjusting the print quality settings. To adjust the print quality settings, reduce the resolution. If you have set the resolution to 1200 dpi (Best), change it to 600 dpi (Normal). See the Software Section. Change the port setting to the USB or network port to improve print speed. Your printer prints A4-sized paper at 33 ppm and letter-sized paper at 35 ppm and your printer prints A4-sized paper at 17 ipm and letter-sized paper at 18 ipm in the duplex printing mode.</td>
</tr>
<tr>
<td></td>
<td>The printer may have insufficient random-access memory (RAM).</td>
<td>Install more memory in your printer. See page 10.1.</td>
</tr>
<tr>
<td>Condition</td>
<td>Possible cause</td>
<td>Suggested solutions</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Half the page is blank.</td>
<td>The page layout is too complex.</td>
<td>Simplify the page layout and remove any unnecessary graphics from the document.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Install more memory in your printer. See page 10.1.</td>
</tr>
<tr>
<td></td>
<td>The page orientation setting may be incorrect.</td>
<td>Change the page orientation in your application. See the Software Section.</td>
</tr>
<tr>
<td></td>
<td>The paper size and the paper size settings do not match.</td>
<td>Ensure that the paper size in the printer driver settings matches the paper in the tray. Or, ensure that the paper size in the printer driver settings matches the paper selection in the software application settings you use.</td>
</tr>
<tr>
<td></td>
<td>There is too much paper in the tray.</td>
<td>Remove excess paper from the tray.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If printing on special materials, use the multi-purpose tray.</td>
</tr>
<tr>
<td></td>
<td>An incorrect type of paper is being used.</td>
<td>Use only paper that meets printer specifications.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If printing on special materials, use the multi-purpose tray.</td>
</tr>
<tr>
<td></td>
<td>An incorrect output method is being used.</td>
<td>Special print materials, such as thick paper, should not be printed using the output tray (face-down). Use the rear cover (face-up) instead.</td>
</tr>
<tr>
<td></td>
<td>There may be debris inside the printer.</td>
<td>Open the front cover and remove the debris.</td>
</tr>
<tr>
<td></td>
<td>If you are under the DOS environment, the font setting for your machine may be set incorrectly.</td>
<td>Change the font setting. See page 2.5.</td>
</tr>
<tr>
<td></td>
<td>The printer cable is loose or defective.</td>
<td>Disconnect and reconnect the printer cable. Try a print job that you have already printed successfully. If possible, attach the cable and printer to another computer and try a print job that you know works. Finally, try a new printer cable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Incompatibility between the PDF file and the Acrobat products.</td>
</tr>
<tr>
<td></td>
<td>The printer prints, but the text is wrong, garbled, or incomplete. (Continued)</td>
<td>The setting in the software application is wrong.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Printing the PDF file as an image may solve this problem. Turn on Print As Image from the Acrobat printing options. Note: it will take longer to print when you print a PDF file as an image.</td>
</tr>
<tr>
<td></td>
<td>Pages print, but are blank.</td>
<td>The print cartridge is defective or out of toner.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Redistribute the print cartridge. See page 8.3.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If necessary, replace the print cartridge. See page 8.3.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The file may have blank pages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check the file to ensure that it does not contain blank pages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Some parts, such as the controller or the board, may be defective.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contact a service representative.</td>
</tr>
<tr>
<td></td>
<td>The illustrations print incorrectly in Adobe Illustrator.</td>
<td>The setting in the software application is wrong.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select Download as Bit Image in the Advanced Options window of the graphic properties. Print the document again.</td>
</tr>
<tr>
<td></td>
<td>The printer does not print PDF file correctly.</td>
<td>Incompatibility between the PDF file and the Acrobat products.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Printing the PDF file as an image may solve this problem. Turn on Print As Image from the Acrobat printing options. Note: it will take longer to print when you print a PDF file as an image.</td>
</tr>
</tbody>
</table>
Solving print quality problems

Dirt inside of the printer or improper paper loading may reduce print quality. See the table below to troubleshoot problems.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Suggested solutions</th>
</tr>
</thead>
</table>
| **Light or faded print**  | If a vertical white streak or faded area appears on the page:  
  • The toner supply is low. You may be able to temporarily extend the print cartridge life. See page 8.3. If this does not improve print quality, install a new print cartridge.  
  • The paper may not meet paper specifications (for example, the paper is too moist or too rough). See page 5.3.  
  • If the entire page is light, the print resolution setting is too light or toner save mode is on. Adjust the print resolution and toner save mode in the printer properties. See the Software Section.  
  • A combination of faded or smeared defects may indicate that the printer needs cleaning. See page 8.1.  
  • The surface of LSU may be dirty. Clean the LSU. See page 8.1.                                                                                                     |
| **Toner spots**           | • The paper may not meet specifications (for example, the paper is too moist or too rough). See page 5.3.  
  • The transfer roller or paper path may be dirty. See page 8.1.                                                                                                                   |
| **Dropouts**              | If generally rounded, faded areas occur randomly on the page:  
  • A single sheet of paper may be defective. Try reprinting the job.  
  • The moisture content of the paper is uneven or the paper has moist spots on its surface. Try a different brand of paper. See page 5.3.  
  • The paper lot is bad. The manufacturing processes can cause some areas to reject toner. Try a different kind or brand of paper.  
  • The print cartridge may be defective. See “Vertical repetitive defects” on the next page.  
  • If these steps do not correct the problems, contact a service representative.                                                                                                |
| **Vertical lines**        | If black vertical streaks appear on the page:  
  • The drum inside the print cartridge has probably been scratched. Install a new print cartridge.                                                                                |
| **Gray background**       | If the amount of background shading becomes unacceptable, the procedures below may fix the problem.  
  • Change to lighter weight pages. See page 5.3.  
  • Check the printer’s environment; very dry (low humidity) or high humidity (higher than 80% RH) conditions can increase the amount of background shading.  
  • Remove the old print cartridge and install a new one. See page 8.3.                                                                                                       |
| **Toner smear**           | • Clean the inside of the printer. See page 8.1.  
  • Check the type and quality. See page 5.2.  
  • Remove the print cartridge and install a new one. See page 8.3.                                                                                                                  |
| **Vertical repetitive defects** | If marks repeatedly appear on the printed side of the page at even intervals:  
  • The print cartridge may be damaged. If a repetitive mark occurs on the page, print a cleaning sheet several times to clean the cartridge; see page 8.1. After the printout, if you still have the same problems, install a new print cartridge. See page 8.3.  
  • Parts of the printer may have toner on them. If the defects occur on the back of the page, the problem will likely correct itself after a few more pages.  
  • The fusing assembly may be damaged. Contact a service representative.                                                                                                        |
### Background scatter

- **Condition**: Background scatter results from bits of toner distributed on the printed page.
- **Suggested solutions**:  
  - The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until necessary so that the paper does not absorb too much moisture.
  - If background scatter occurs on an envelope, change the printing layout to avoid printing over areas that have overlapping seams on the reverse side. Printing on seams can cause problems.
  - If background scatter covers the entire surface area of a printed page, adjust the print resolution through your software application or via the printer properties window.

### Misformed characters

- **Condition**: Misformed characters  
- **Suggested solutions**:  
  - If characters are improperly formed and producing hollowed images, the paper stock may be too slick. Try a different paper. See page 5.3.
  - If characters are improperly formed and producing a wavy effect, the scanner unit may need service. Verify that it also occurs on a demo page (see page 2.7). For service, contact a service representative.

### Page skew

- **Condition**: Page skew  
- **Suggested solutions**:  
  - Ensure that the paper is loaded properly.
  - Check the paper type and quality. See page 5.2.
  - Ensure that the paper or other material is loaded correctly and the guides are not too tight or too loose against the paper stack.

### Curl or wave

- **Condition**: Curl or wave  
- **Suggested solutions**:  
  - Ensure that the paper is loaded properly.
  - Check the type and quality. Both high temperature and humidity can cause paper curl. See page 5.2.
  - Turn over the stack of paper in the tray. Also try rotating the paper 180° in the tray.
  - Try printing to the rear cover (face-up).

### Wrinkles or creases

- **Condition**: Wrinkles or creases  
- **Suggested solutions**:  
  - Ensure that the paper is loaded properly.
  - Check the paper type and quality. See page 5.2.
  - Open the rear cover and try printing to the rear cover (face-up).
  - Turn over the stack of paper in the tray. Also try rotating the paper 180° in the tray.

### Back of printouts are dirty

- **Condition**: Back of printouts are dirty  
- **Suggested solutions**:  
  - The transfer roller may be dirty. See page 8.1.
  - Check for leaking toner. Clean the inside of the printer.

### Solid color or Black pages

- **Condition**: Solid color or Black pages  
- **Suggested solutions**:  
  - The print cartridge may not be installed properly. Remove the cartridge and reinsert.
  - The print cartridge may be defective and need replacing. Install a new print cartridge.
  - The printer may require repair. Contact a service representative.

### Loose toner

- **Condition**: Loose toner  
- **Suggested solutions**:  
  - Clean the inside of the printer.
  - Check the paper type and quality. See page 5.2.
  - Install a new print cartridge. See page 8.3.
  - If the problem persists, the printer may require repair. Contact a service representative.

### Character Voids

- **Condition**: Character Voids  
- **Suggested solutions**:  
  - Character voids are white areas within characters that should be solid black:
    - If you are using transparencies, try another type of transparency. Because of the composition of the transparency, some character voids may be normal.
    - You may be printing on the wrong surface on the paper. Remove the paper and turn it around.
    - The paper may not meet paper specifications. See page 5.3.

### Horizontal stripes

- **Condition**: Horizontal stripes  
- **Suggested solutions**:  
  - If horizontally aligned black streaks or smears appear:
    - The print cartridge may be installed improperly. Remove the cartridge and reinsert.
    - The print cartridge may be defective. Install a new print cartridge. See page 8.3.
    - If the problem persists, the printer may require repair. Contact a service representative.
### Common Windows problems

<table>
<thead>
<tr>
<th>Condition</th>
<th>Suggested solutions</th>
</tr>
</thead>
</table>
| Curl | If the printed paper is curled or paper does not feed into the printer:  
- Turn over the stack of paper in the tray. Also try rotating the paper 180° in the tray.  
- Try printing to rear cover. |
| An unknown image repetitively appears on a next few sheets or loose toner, light print, or contamination occurs. | Your printer is probably being used at an altitude of 1,000 m (3,281 ft) or above.  
The high altitude may affect the print quality such as loose toner or light imaging. You can set this option through **Printer Settings Utility** or **Altitude Adj.** in **System setup** menu. See page 2.4. |

### Common PostScript problems

The following situations are PostScript language specific and may occur when several printer languages are being used.

**Note**
To receive a printed or screen displayed message when PostScript errors occur, open the Print Options window and click the desired selection next to the PostScript errors section.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Possible cause</th>
<th>Suggested solutions</th>
</tr>
</thead>
</table>
| PostScript file can not be printed. | The PostScript driver may not be installed correctly. | - Print a configuration page and verify that the PostScript version is available for printing.  
- Install the PostScript driver.  
- If problem consists, contact a service representative. |
| "Limit Check Error" message appears. | The print job was too complex. | You might need to reduce the complexity of the page or install more memory. |
| A PostScript error page prints. | Print job may not be PostScript. | Make sure that the print job is a PostScript job. Check to see whether the software application expected a setup or PostScript header file to be sent to the printer. |
| The optional tray 2 is not selected in the driver. | The printer driver has not been configured to recognize the optional tray 2. | Open the PostScript driver properties, select the **Device Settings** tab, and set the **Tray2** option of the **Installable Options** section to **Installed**. |

**Note**
Refer to Microsoft Windows 2000/XP/2003 User’s Guide that came with your PC for further information on Windows error messages.
### Common Linux problems

<table>
<thead>
<tr>
<th>Condition</th>
<th>Suggested solutions</th>
</tr>
</thead>
</table>
| The printer doesn’t print. | • Check if the printer driver is installed in your system. Open Unified Driver Configurator and switch to the Printers tab in Printers configuration window to look at the list of available printers. Make sure that your machine is displayed on the list. If not, please, invoke Add new printer wizard to set up your device.  
• Check if the printer is started. Open Printers configuration and select your machine on the printers list. Look at the description in the Selected printer pane. If its status contains "(stopped)" string, please, press the Start button. After that normal operation of the printer should be restored. The "stopped" status might be activated when some problems in printing occurred.  
• Check if your application has special print option such as "-oraw". If "-oraw" is specified in the command line parameter then remove it to print properly. For Gimp front-end, select "print" -> "Setup printer" and edit command line parameter in the command item. |
| I encounter error “Unable to open MFP port device file!” when printing a document. | Please avoid changing print job parameters (via LPR GUI, for example) while a print job is in progress. Known versions of CUPS server break the print job whenever print options are changed and then try to restart the job from the beginning. Since Unified Linux Driver locks port while printing, the abrupt termination of the driver keeps the port locked and therefore unavailable for subsequent print jobs. If this situation occurred, please, try to release the port. |
| When printing a document over the network in SuSE 9.2, the printer does not print. | The CUPS (Common Unix Printing System) version distributed with SuSE Linux 9.2 (cups-1.1.21) has a problem with IPP (Internet Printing Protocol) printing. Use the socket printing instead of IPP or install later version of CUPS (cups-1.1.22 or higher). |

### Common Macintosh problems

<table>
<thead>
<tr>
<th>Condition</th>
<th>Suggested solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer does not print PDF file correctly. Some parts of graphics, text, or illustrations are missing.</td>
<td>Incompatibility between the PDF file and the Acrobat products: Printing the PDF file as an image may solve this problem. Turn on Print As Image from the Acrobat printing options. Note: it will take longer to print when you print a PDF file as an image.</td>
</tr>
<tr>
<td>The document has printed, but the print job has not disappeared from the spooler in Mac OS 10.3.2.</td>
<td>Update your Mac OS to OS 10.3.3 or higher.</td>
</tr>
<tr>
<td>When print a document in Macintosh with Acrobat Reader 6.0 or higher, colors print incorrectly.</td>
<td>The resolution setting in the printer driver may not be matched with that in Acrobat Reader. Make sure that the resolution setting in your printer driver matches that in Acrobat Reader.</td>
</tr>
</tbody>
</table>
10 Installing accessories

Your printer is a full-featured laser printer that has been optimized to meet most of your printing needs. Recognizing that each user may have different requirements, however, Xerox makes several accessories available to enhance the printer’s capabilities.

This chapter includes:

- Precautions when installing accessories
- Installing a memory DIMM

---

Precautions when installing accessories

Disconnect the power cord:

Never remove the control board cover while the power is being supplied.

To avoid the possibility of an electrical shock, always disconnect the power cord when installing or removing ANY internal or external accessories.

Discharge static electricity:

The control board and internal accessories (network interface card and memory DIMM) are sensitive to static electricity. Before installing or removing an internal accessories, discharge static electricity from your body by touching something metal, such as the metal back plate on any device plugged into a grounded power source. If you walk around before finishing installation, discharge any static electricity once again.

---

Installing a memory DIMM

Your printer has a dual in-line memory module (DIMM) slot. Use this DIMM slot to install additional memory.

**Phaser 3435/DN** has 64 MB of memory which can be expanded to 320 MB.

For order information for optional memory DIMM’s, see page 7.1.

1. Turn the printer power off and unplug all cables from the printer.
2. Grasp the control board cover and slide toward you to open it.
3. Completely open the latch on each side of the DIMM slot.
4. Take out a new memory DIMM from the plastic bag.
5. Holding the memory DIMM by the edges, align the notches on the memory DIMM with the grooves on the memory DIMM slot.

6. Push the DIMM straight into the DIMM slot until it snaps into place. Make sure the latches fit over the notches located on either side of the DIMM.

7. Replace the control board cover.

8. Reconnect the power cord and printer cable, and turn the printer on.

---

Setting the memory in the PostScript printer properties

After installing the memory DIMM, you need to select it in the printer properties of the PostScript printer driver so that you can use it.

1. Make sure that the PostScript printer driver is installed in your computer. To installing the PostScript printer driver, you need to select Custom and put a check mark on the PostScript printer driver. See the Software Section.

2. Click the Windows Start menu.

3. For Windows 2000, select Settings and then Printers.
   For Windows XP/2003, select Printers and Faxes.
   For Windows Vista, select Control Panel -> Hardware and Sound -> Printers.

4. Select the Xerox Phaser 3435 printer.

5. Click the right mouse button on the printer icon and select Properties.


7. Select the amount of memory you installed from Printer Memory in the Installable Option section.

8. Click OK.
# 11 Specifications

This chapter includes:

- Printer specifications

## Printer specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specifications and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Model name</strong></td>
<td>Phaser 3435/DN</td>
</tr>
<tr>
<td><strong>Printing speed</strong>a</td>
<td>33 ppm (A4); 35 ppm (Letter)&lt;br&gt;Duplex: 17 ipm (A4); 17.5 ipm (Letter)</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>Up to 1200 x 1200 dpi effective output</td>
</tr>
<tr>
<td><strong>Warm-up time</strong></td>
<td>Less than 15 seconds</td>
</tr>
<tr>
<td><strong>First print out time</strong></td>
<td>Standby mode: 8.5 seconds&lt;br&gt;Sleep mode: 25 seconds</td>
</tr>
<tr>
<td><strong>Power rating</strong></td>
<td>110 - 127 VAC or 220 - 240 VAC&lt;br&gt;See the Rating label on the machine for the correct voltage, frequency(hertz) and type of current for your machine.</td>
</tr>
<tr>
<td><strong>Power consumption</strong></td>
<td>Average: 400 W&lt;br&gt;Power save mode: Less than 11 W</td>
</tr>
<tr>
<td><strong>Noise level</strong>b</td>
<td>Standby mode: Less than 25dBA&lt;br&gt;Printing mode: Less than 54 dBA</td>
</tr>
<tr>
<td><strong>Print cartridge life</strong>c</td>
<td>• Starter Print cartridge: 4,000 pages&lt;br&gt;• Standard: 4,000 pages&lt;br&gt;• High yield: 10,000 pages&lt;br&gt;(Declared yield value in accordance with ISO/IEC 19752.)</td>
</tr>
<tr>
<td><strong>Duty cycle</strong></td>
<td>Monthly: Up to 80,000 pages</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>Gross: 15.62 Kg / Net: 12.7 Kg</td>
</tr>
<tr>
<td><strong>Package weight</strong></td>
<td>Paper: 1.8 Kg, Plastic: 0.52 Kg</td>
</tr>
<tr>
<td><strong>External dimensions</strong> (W x D x H)</td>
<td>400 x 435 x 314 mm (15.7 x 17.1 x 12.4 inches)</td>
</tr>
<tr>
<td><strong>Operating environment</strong></td>
<td>Temperature: 10 ~ 32° C (50 ~ 90° F)&lt;br&gt;Humidity: 20 ~ 80% RH</td>
</tr>
<tr>
<td><strong>Printer language</strong></td>
<td>PCL 6d, PostScript 3, IBM ProPrinter, EPSON, SPL</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>• 64 MB (Max 320 MB)&lt;br&gt;• 32, 128, or 256 MB optional memory available.&lt;br&gt;• Use only the Xerox-approved DIMM.</td>
</tr>
<tr>
<td><strong>Fonts</strong></td>
<td>1 bitmap, 45 scalable, 136 PostScript3 fonts</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>• IEEE 1284 Bidirectional Parallel Standard&lt;br&gt;- Modes supported: Compatible, Nibble, Byte, ECP&lt;br&gt;- USB Interface Standard&lt;br&gt;- USB 2.0 compliant&lt;br&gt;- 480 Mbps 1 port&lt;br&gt;- Network Interface&lt;br&gt;- 10/100 Base TX</td>
</tr>
<tr>
<td><strong>OS compatibility</strong>e</td>
<td>• Windows 2000/XP/2003./Vista&lt;br&gt;• Various Linux OS.&lt;br&gt;• Mac 10.3 ~ 10.5</td>
</tr>
<tr>
<td><strong>Options</strong></td>
<td>250-sheet tray</td>
</tr>
</tbody>
</table>

a. Print speed will be affected by operating system used, computing performance, application software, connection method, media type, media size, and job complexity.

b. Sound pressure Level, ISO7779
c. The number of pages may be affected by operating environment, printing interval, media type, and media size.
d. Compatible with PCL6 Version 2.1
e. Please visit [www.xerox.com/office/support](http://www.xerox.com/office/support) to download the latest software version.
INDEX

A
accessories
  installing
    memory DIMM 10.1
  order information 7.1

C
cleaning
  drum 8.2
  inside 8.1
  outside 8.1
  cleaning sheet, print 8.2
  component location 1.2
  control panel
    menus 2.1
    status LED 1.4

D
demo page, print 2.7
  DIMM, install 10.1
  display language, change
    control panel 2.7
  drum, clean 8.2

E
error messages 9.6

H
high altitude 9.13

I
installing accessories
  memory 10.1

J
jam, clear 9.1

L
Linux problems 9.14
  loading paper
    multi-purpose tray 5.6
    tray 1/optional tray 2 5.5

M
Macintosh problems 9.14
  manual feed mode 5.7
  memory DIMM, install 10.1
  multi-purpose tray 5.6

N
network setup
  802.1x 4.3
  CentreWare IS 4.3
  EtherTalk 4.2
  operating systems 4.1
  TCP/IP 4.2

O
output location, select 5.8
  output tray 5.8

P
paper guidelines 5.3
paper jam, clear
  around the print cartridge 9.3
  duplex area 9.4
  multi-purpose tray 9.2
  optional tray 2 9.2
  paper exit area 9.3
  tray 1 9.1
paper level indicator 5.4
paper load
  multi-purpose tray 5.6
  tray 1/optional tray 2 5.5
paper size
  setting 2.3

Q
quality problems 9.11

R
rear cover, use 5.8
  replacement parts 8.4
  replacing, print cartridge 8.3, 8.4

S
special print media, guidelines 5.3
specification, printer 11.1
status LED 1.4
supplies
  checking life 8.2
  order information 7.1
  system requirements
    Mac OS 3.2
Windows 3.2

T
toner save mode, use 2.7

W
Windows problems 9.13
Software section
Chapter 1: **Installing Printer Software in Windows**

- Installing Printer Software ................................................................. 4
- Installing Software for Local Printing .................................................. 4
- Installing Software for Network Printing .............................................. 7
- Reinstalling Printer Software ............................................................... 10
- Removing Printer Software ................................................................. 10

Chapter 2: **Using SetIP**

- Installing SetIP ..................................................................................... 11
- Using SetIP ........................................................................................... 11

Chapter 3: **Basic Printing**

- Printing a Document ............................................................................ 12
- Printing to a file (PRN) .............................................................. 13
- Printer Settings .................................................................................. 13
  - Layout Tab ......................................................................................... 14
  - Paper Tab ......................................................................................... 14
  - Graphics Tab .................................................................................. 15
  - Extras Tab ....................................................................................... 16
  - Troubleshooting Tab ....................................................................... 17
  - Printer Tab ....................................................................................... 17
- Using a Favorite Setting ...................................................................... 17
- Using Help .......................................................................................... 17

Chapter 4: **Advanced Printing**

- Printing Multiple Pages on One Sheet of Paper (N-Up Printing) .......... 18
- Printing Posters ................................................................................. 19
- Printing Booklets ............................................................................... 19
Installing Printer Software in Windows

This chapter includes:
- Installing Printer Software
- Reinstalling Printer Software
- Removing Printer Software

Installing Printer Software

You can install the printer software for local printing or network printing. To install the printer software on the computer, perform the appropriate installation procedure depending on the printer in use.

A printer driver is software that lets your computer communicate with your printer. The procedure to install drivers may differ depending on the operating system you are using.

All applications should be closed on your PC before beginning installation.

Installing Software for Local Printing

A local printer is a printer directly attached to your computer using the printer cable supplied with your printer, such as a USB or parallel cable. If your printer is attached to a network, skip this step and go to "Installing Software for Network Printing" on page 7.

You can install the printer software using the typical or custom method.

**NOTE:** If the “New Hardware Wizard” window appears during the installation procedure, click x in the upper right corner of the box to close the window, or click Cancel.

**Typical Installation**

This is recommended for most users. All components necessary for printer operations will be installed.

1. Make sure that the printer is connected to your computer and powered on.

2. Insert the supplied CD-ROM into your CD-ROM drive. The CD-ROM should automatically run, and an installation window appears.

   If the installation window does not appear, click Start and then Run. Type X:\Setup.exe, replacing “X” with the letter which represents your drive and click OK. If you use Windows Vista, click Start → All programs → Accessories → Run, and type X:\Setup.exe.

   If the AutoPlay window appears in Windows Vista, click Run Setup.exe in Install or run program field, and click Continue in the User Account Control window.

3. Click Install Software.

4. Select Typical installation for a local printer. Click Next.

   ![Typical Installation Window]
**NOTE:** If your printer is not already connected to the computer, the following window will appear.

![Printer Connection Window](image)

- After connecting the printer, click **Next**.
- If you don’t want to connect the printer at this time, click **Next**, and **No** on the following screen. Then the installation will start and a test page will not be printed at the end of the installation.

The installation window that appears in this User’s Guide may differ depending on the printer and interface in use.

5 After the installation is finished, a window asking you to print a test page appears. If you choose to print a test page, select the checkbox and click **Next**.
   Otherwise, just click **Next** and skip to step 7.

6 If the test page prints out correctly, click **Yes**.
   If not, click **No** to reprint it.

7 Click **Finish**.

**NOTE:** After setup is complete, if your printer driver doesn’t work properly, reinstall the printer driver. See "Reinstalling Printer Software" on page 10.

---

**Custom Installation**

You can choose individual components to install.

1 Make sure that the printer is connected to your computer and powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive. The CD-ROM should automatically run, and an installation window appears.
   If the installation window does not appear, click **Start** and then **Run**. Type `X:\Setup.exe`, replacing “X” with the letter which represents your drive and click **OK**.
   If you use Windows Vista, click **Start → All programs → Accessories → Run**, and type `X:\Setup.exe`.
   If the **AutoPlay** window appears in Windows Vista, click **Run Setup.exe** in **Install or run program** field, and click **Continue** in the **User Account Control** window.

3 Click **Install Software**.

4 Select **Custom installation**. Click **Next**.

5 Make sure that the printer is connected to your computer and powered on.

6 Insert the supplied CD-ROM into your CD-ROM drive. The CD-ROM should automatically run, and an installation window appears.
   If the installation window does not appear, click **Start** and then **Run**. Type `X:\Setup.exe`, replacing “X” with the letter which represents your drive and click **OK**.
   If you use Windows Vista, click **Start → All programs → Accessories → Run**, and type `X:\Setup.exe`.
   If the **AutoPlay** window appears in Windows Vista, click **Run Setup.exe** in **Install or run program** field, and click **Continue** in the **User Account Control** window.

3 Click **Install Software**.

4 Select **Custom installation**. Click **Next**.

5 Make sure that the printer is connected to your computer and powered on.

6 Insert the supplied CD-ROM into your CD-ROM drive. The CD-ROM should automatically run, and an installation window appears.
   If the installation window does not appear, click **Start** and then **Run**. Type `X:\Setup.exe`, replacing “X” with the letter which represents your drive and click **OK**.
   If you use Windows Vista, click **Start → All programs → Accessories → Run**, and type `X:\Setup.exe`.
   If the **AutoPlay** window appears in Windows Vista, click **Run Setup.exe** in **Install or run program** field, and click **Continue** in the **User Account Control** window.

3 Click **Install Software**.

4 Select **Custom installation**. Click **Next**.
5 Select your printer and click **Next**.

![Image of printer setup window]

**NOTE:** If your printer is not already connected to the computer, the following window will appear.

![Image of printer setup window with options]

- After connecting the printer, click **Next**.
- If you don’t want to connect the printer at this time, click **Next**, and **No** on the following screen. Then the installation will start and a test page will not be printed at the end of the installation.

**The installation window that appears in this User’s Guide may differ depending on the printer and interface in use.**

6 Select the components to be installed and click **Next**.

![Image of selected components window]

**NOTE:** You can change the desired installation folder by clicking [Browse].

7 After the installation is finished, a window asking you to print a test page appears. If you choose to print a test page, select the checkbox and click **Next**. Otherwise, just click **Next** and skip to step 9.

8 If the test page prints out correctly, click **Yes**. If not, click **No** to reprint it.

9 Click **Finish**.

![Image of completion window]
Installing Software for Network Printing

When you connect your printer to a network, you must first configure the TCP/IP settings for the printer. After you have assigned and verified the TCP/IP settings, you are ready to install the software on each computer on the network.

You can install the printer software using the typical or custom method.

Typical Installation

This is recommended for most users. All components necessary for printer operations will be installed.

1. Make sure that the printer is connected to your network and powered on. For details about connecting to the network, see the supplied printer’s User’s Guide.

2. Insert the supplied CD-ROM into your CD-ROM drive. The CD-ROM should automatically run, and an installation window appears.

If the installation window does not appear, click Start and then Run. Type X:\Setup.exe, replacing “X” with the letter which represents your drive and click OK.

If you use Windows Vista, click Start → All programs → Accessories → Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista, click Run Setup.exe in Install or run program field, and click Continue in the User Account Control window.

3. Click Install Software.

4. Select Typical installation for a network printer. Click Next.

5. The list of printers available on the network appears. Select the printer you want to install from the list and then click Next.

6. After the installation is finished, a window asking you to print a test page appears. If you choose to print a test page, select the checkbox and click Next. Otherwise, just click Next and skip to step 8.

7. If the test page prints out correctly, click Yes. If not, click No to reprint it.

8. Click Finish.
**NOTE:** After setup is complete, if your printer driver doesn’t work properly, reinstall the printer driver. See "Reinstalling Printer Software" on page 10.

### Custom Installation

You can choose individual components to install and set a specific IP address.

1. Make sure that the printer is connected to your network and powered on. For details about connecting to the network, see the supplied printer’s User’s Guide.

2. Insert the supplied CD-ROM into your CD-ROM drive. The CD-ROM should automatically run, and an installation window appears. If the installation window does not appear, click **Start** and then **Run**. Type `X:\Setup.exe`, replacing “X” with the letter which represents your drive and click **OK**. If you use Windows Vista, click **Start → All programs → Accessories → Run**, and type `X:\Setup.exe`. If the **AutoPlay** window appears in Windows Vista, click **Run Setup.exe** in **Install or run program** field, and click **Continue** in the **User Account Control** window.

3. Click **Install Software**.

4. Select **Custom installation**. Click **Next**.

5. The list of printers available on the network appears. Select the printer you want to install from the list and then click **Next**.

6. If you do not see your printer on the list, click **Update** to refresh the list, or select **Add TCP/IP Port** to add your printer to the network. To add the printer to the network, enter the port name and the IP address for the printer. To verify your printer’s IP address or the MAC address, print a Network Configuration page.

   - If you cannot find your machine in network, please turn off the firewall and click **Update**.

   For Windows operating system, click **Start → Control Panel** and start windows firewall, and set this option unactivated. For other operating system, refer to its on-line guide.
TIP: If you want to set a specific IP address on a specific network printer, click the Set IP Address button. The Set IP Address window appears. Do as follows:

a. Select a printer to be set with a specific IP address from the list.
b. Configure an IP address, subnet mask, and gateway for the printer manually and click Configure to set the specific IP address for the network printer.
c. Click Next.

6 Select the components to be installed and click Next.

7 You can also change the printer name, set the printer to be shared on the network, set the printer as the default printer, and change the port name of each printer. Click Next.

8 After the installation is finished, a window asking you to print a test page appears. If you choose to print a test page, select the checkbox and click Next. Otherwise, just click Next and skip to step 10.

9 If the test page prints out correctly, click Yes. If not, click No to reprint it.

10 Click Finish.

NOTE: After setup is complete, if your printer driver doesn’t work properly, reinstall the printer driver. See "Reinstalling Printer Software" on page 10.
Reinstalling Printer Software

You can reinstall the software if installation fails.

1 Start Windows.
2 From the Start menu select Programs or All Programs → your printer driver name → Maintenance.
3 Select Repair and click Next.
4 The list of printers available on the network appears. Select the printer you want to install from the list and then click Next.

- If you do not see your printer on the list, click Update to refresh the list, or select Add TCP/IP Port to add your printer to the network. To add the printer to the network, enter the port name and the IP address for the printer.
- To find a shared network printer (UNC Path), select Shared Printer [UNC] and enter the shared name manually or find a shared printer by clicking the Browse button.

You will see a component list so that you can reinstall any item individually.

NOTE: If your printer is not already connected to the computer, the following window will appear.

- After connecting the printer, click Next.
- If you don’t want to connect the printer at this time, click Next, and No on the following screen. Then the installation will start and a test page will not be printed at the end of the installation.
- The reinstallation window that appears in this User’s Guide may differ depending on the printer and interface in use.

5 Select the components you want to reinstall and click Next.

If you installed the printer software for local printing and you select your printer driver name, the window asking you to print a test page appears. Do as follows:

a. To print a test page, select the check box and click Next.

b. If the test page prints out correctly, click Yes.

If it doesn’t, click No to reprint it.

6 When the reinstallation is done, click Finish.

Removing Printer Software

1 Start Windows.
2 From the Start menu select Programs or All Programs → your printer driver name → Maintenance.
3 Select Remove and click Next.

You will see a component list so that you can remove any item individually.

4 Select the components you want to remove and then click Next.

5 When your computer asks you to confirm your selection, click Yes.

The selected driver and all of its components are removed from your computer.

6 After the software is removed, click Finish.
Using SetIP

- Installing SetIP
- Using SetIP

Installing SetIP

1. Make sure that the printer is connected to your computer and powered on.

2. Insert the supplied CD-ROM into your CD-ROM drive. The CD-ROM should automatically run, and an installation window appears. If the installation window does not appear, click Start and then Run. Type X:\Setup.exe, replacing "X" with the letter which represents your drive and click OK.

3. Click Install SetIP Utility(Optional).

4. Click Next.

5. Click Next.

6. Click Finish.

Using SetIP

1. From the Windows Start menu, select Programs or All Programs ➔ your printer driver name ➔ SetIP ➔ SetIP.

   The program automatically detects and displays new and configured print servers on your network.

2. Select the name of your printer and click . If you cannot find your printer name, click to refresh the list.

   NOTES:
   - To confirm the MAC address, see the NETWORK PRINTER CARD TEST PAGE. The NETWORK PRINTER CARD TEST PAGE will be printed after the Configuration Page.
   - The refreshed list doesn’t show your printer, click enter your network printer card’s IP address, subnet mask, default gateway, and then click Apply.

3. Click OK to confirm the settings.

4. Click Exit to close the SetIP program.
Basic Printing

This chapter explains the printing options and common printing tasks in Windows.

This chapter includes:
- Printing a Document
- Printer Settings
  - Layout Tab
  - Paper Tab
  - Graphics Tab
  - Extras Tab
  - Troubleshooting Tab
  - Printer Information Page
  - Using a Favorite Setting
  - Using Help

Printing a Document

**NOTES:**
- Your printer driver Properties window that appears in this User’s Guide may differ depending on the printer in use. However the composition of the printer properties window is similar.
- Check the Operating System(s) that are compatible with your printer. Please refer to the OS Compatibility section of Printer Specifications in your Printer User’s Guide.
- If you need to know the exact name of your printer, you can check the supplied CD-ROM.

The following procedure describes the general steps required for printing from various Windows applications. The exact steps for printing a document may vary depending on the application program you are using. Refer to the User’s Guide of your software application for the exact printing procedure.

1. Open the document you want to print.
2. Select Print from the File menu. The Print window is displayed. It may look slightly different depending on your application.
   The basic print settings are selected within the Print window. These settings include the number of copies and print range.

   ![Print Settings Window]
   Make sure that your printer is selected.

3. Select your printer driver from the Name drop-down list.
4. To take advantage of the printer features provided by your printer driver, click Properties or Preferences in the application’s Print window. For details, see "Printer Settings" on page 13.
   If you see Setup, Printer, or Options in your Print window, click it instead. Then click Properties on the next screen.
5. Click OK to close the printer properties window.
6. To start the print job, click OK or Print in the Print window.
**Printing to a file (PRN)**

You will sometimes need to save the print data as a file for your purpose.

To create a file:

1. **Check the Print to file box at the Print window.**

2. Select the folder and assign a name of the file and then click OK.

**Printer Settings**

You can use the printer properties window, which allows you to access all of the printer options you need when using your printer. When the printer properties are displayed, you can review and change the settings needed for your print job.

Your printer properties window may differ, depending on your operating system. This Software User’s Guide shows the Properties window for Windows XP.

Your printer driver Properties window that appears in this User’s Guide may differ depending on the printer in use.

If you access printer properties through the Printers folder, you can view additional Windows-based tabs (refer to your Windows User’s Guide) and the Printer tab (see "Printer Information Page" on page 17).

**NOTES:**

- Most Windows applications will override settings you specify in the printer driver. Change all print settings available in the software application first, and change any remaining settings using the printer driver.
- The settings you change remain in effect only while you are using the current program. To make your changes permanent, make them in the Printers folder.
- The following procedure is for Windows XP. For other Windows OS, refer to the corresponding Windows User’s Guide or online help.
  1. Click the Windows Start button.
  2. Select Printers and Faxes.
  3. Select your printer driver icon.
  4. Right-click on the printer driver icon and select Printing Preferences.
  5. Change the settings on each tab, click OK.
Layout Tab

The **Layout** tab provides options to adjust how the document appears on the printed page. The **Layout Options** includes **Multiple Pages per Side** and **Poster Printing**. See "Printing a Document" on page 12 for more information on accessing printer properties.

![Layout Tab Diagram](image)

**Paper Orientation**

**Paper Orientation** allows you to select the direction in which information is printed on a page.
- **Portrait** prints across the width of the page, letter style.
- **Landscape** prints across the length of the page, spreadsheet style.
- **Rotate** allows you to rotate the page the selected degrees

![Orientation Diagram](image)

**Layout Options**

**Layout Options** allows you to select advanced printing options. You can choose **Multiple Pages per Side** and **Poster Printing**.
- For details, see "Printing Multiple Pages on One Sheet of Paper (N-Up Printing)" on page 18.
- For details, see "Printing Posters" on page 19

**Double-sided Printing**

**Double-sided Printing** allows you to print on both sides of paper. *If this option does not appear, your printer does not have this feature.*
- For details, see "Printing on Both Sides of Paper" on page 20.

---

Paper Tab

Use the following options to set the basic paper handling specifications when you access the printer properties. See "Printing a Document" on page 12 for more information on accessing printer properties.

Click the **Paper** tab to access various paper properties.

![Paper Tab Diagram](image)

1. **Copies**
   - **Copies** allows you to choose the number of copies to be printed. You can select 1 to 999 copies.

2. **Size**
   - **Size** allows you to set the size of paper you loaded in tray. If the required size is not listed in the **Size** box, click **Custom**. When the **Custom Paper Setting** window appears, set the paper size and click **OK**. The setting appears in the list so that you can select it.

---

Basic Printing
Source
Make sure that Source is set to the corresponding paper tray. Use Manual Feeder when printing on special materials like envelopes and transparencies. You have to load one sheet at a time into Manual Tray or Multi-Purpose Tray. If the paper source is set to Auto Selection, the printer automatically picks up print material in the following tray order: Manual Tray or Multi-Purpose Tray (Tray1), Tray2, optional Tray n.

Type
Set Type to correspond to the paper loaded in tray from which you want to print. This will let you get the best quality printout. If not, print quality may not be achieved as you want.
Cotton: 20 lb to 24 lb (75~90 g/m2) cotton paper such as Gilbert 25 % and Gilbert 100 %.
Plain Paper: Normal plain paper. Select this type if your printer is monochrome and printing on the 16 lb (60 g/m2) cotton paper.
Recycled Paper: 20 lb to 24 lb (75~90 g/m2) recycled paper.
Color Paper: 20 lb to 24 lb (75~90 g/m2) color-backgrounded paper.

First Page
This property allows you to print the first page using a different paper type from the rest of the document. You can select the paper source for the first page. For example, load thick stock for the first page into the Multi-purpose Tray, and plain paper into Tray n. Then, select Tray n in the Source option and Multi-Purpose Tray in the First Page option. If this option does not appear, your printer does not have this feature.

Scaling Printing
Scaling Printing allows you to automatically or manually scale your print job on a page. You can choose from None, Reduce/Enlarge, and Fit to Page.
- For details, see "Printing a Reduced or Enlarged Document" on page 20.
- For details, see "Fitting Your Document to a Selected Paper Size" on page 20.

Graphics Tab
Use the following Graphic options to adjust the print quality for your specific printing needs. See "Printing a Document" on page 12 for more information on accessing printer properties.
Click the Graphic tab to display the properties shown below.

Resolution
The Resolution options you can select may vary depending on your printer model. The higher the setting, the sharper the clarity of printed characters and graphics. The higher setting also may increase the time it takes to print a document.

Image Mode
The available options are Normal and Text Enhance. Some printers do not support this feature.
- Printer Setting: If you select this option, this feature is determined by the setting you’ve made on the control panel of the printer.
- Normal: This setting is for normal documents.
- Text Enhancement: Image Mode allows the user to enhance printouts.

Toner Save Mode
Selecting this option extends the life of your print cartridge and reduces your cost per page without a significant reduction in print quality.
- Printer Setting: If you select this option, this feature is determined by the setting you’ve made on the control panel of the printer.
- On: Select this option to allow the printer to use less toner on each page.
- Off: If you don’t need to save toner when printing a document, select this option.
Advanced Options
You can set advanced settings by clicking the Advanced Options button.

• TrueType Options: This option determines what the driver tells the printer about how to image the text in your document. Select the appropriate setting according to the status of your document.
  - Download as Outline: When this option is selected, the driver will download any TrueType fonts that are used in your document not already stored (resident) on your printer. If, after printing a document, you find that the fonts did not print correctly, choose Download as bit image and resubmit your print job. The Download as bit image setting is often useful when printing Adobe. **This feature is available only when you use the PCL printer driver.**
  - Download as Bitmap: When this option is selected, the driver will download the font data as bitmap images. Documents with complicated fonts, such as Korean or Chinese, or various other fonts, will print faster in this setting.
  - Print as Graphics: When this option is selected, the driver will download any fonts as graphics. When printing documents with high graphic content and relatively few TrueType fonts, printing performance (speed) may be enhanced in this setting.
  • Print All Text To Black: When the Print All Text To Black option is checked, all text in your document prints solid black, regardless of the color it appears on the screen.

Extras Tab
You can select output options for your document. See "Printing a Document" on page 12 for more information about accessing the printer properties.

Click the Extras tab to access the following feature:

1. Watermark
You can create a background text image to be printed on each page of your document. For details, see "Using Watermarks" on page 21.

2. Overlay
Overlays are often used to take the place of preprinted forms and letterhead paper. For details, see "Using Overlays" on page 22.

3. Output Options
  • Print Subset: You can set the sequence in which the pages print. Select the print order from the drop-down list.
    - Normal: Your printer prints all pages from the first page to the last page.
    - Reverse All Pages(3,2,1): Your printer prints all pages from the last page to the first page.
    - Print Odd Pages: Your printer prints only the odd numbered pages of the document.
    - Print Even Pages: Your printer prints only the even numbered pages of the document.
  • Use Printer Fonts: When Use Printer Fonts is checked, the printer uses the fonts that are stored in its memory (resident fonts) to print your document, rather than downloading the fonts used in your document. Because downloading fonts takes time, selecting this option can speed up your printing time. When using Printer fonts, the printer will try to match the fonts used in your document to those stored in its memory. If, however, you use fonts in your document that are very different from those resident in the printer, your printed output will appear very different from what it looks like on the screen. **This feature is available only when you use the PCL printer driver.**
Troubleshooting Tab

Click the Troubleshooting tab to access the following feature:

1 Printer Information Page
To print information pages or to perform diagnostic actions, select an item from the list below and click Print.

2 Web Links
If you have an Internet connection and a browser installed, click one of the web links to connect to a web page directly from the driver.

3 About
Use the About tab to display the copyright notice and the version number of the driver.

Using a Favorite Setting

The Favorites option, which is visible on each properties tab, allows you to save the current properties settings for future use.

To save a Favorites item:
1 Change the settings as needed on each tab.
2 Enter a name for the item in the Favorites input box.
3 Click Save.

When you save Favorites, all current driver settings are saved.

To use a saved setting, select the item from the Favorites drop down list. The printer is now set to print according to the Favorites setting you selected.

To delete a Favorites item, select it from the list and click Delete.

You can also restore the printer driver’s default settings by selecting Printer Default from the list.

Using Help

Your printer has a help screen that can be activated by clicking the Help button in the printer properties window. These help screens give detailed information about the printer features provided by the printer driver.

You can also click  from the upper right corner of the window, and then click on any setting.
This chapter explains printing options and advanced printing tasks.

NOTES:
• Your printer driver Properties window that appears in this User’s Guide may differ depending on the printer in use. However the composition of the printer properties window is similar.
• If you need to know the exact name of your printer, you can check the supplied CD-ROM.

This chapter includes:
• Printing Multiple Pages on One Sheet of Paper (N-Up Printing)
• Printing Posters
• Printing Booklets
• Printing on Both Sides of Paper
• Printing a Reduced or Enlarged Document
• Fitting Your Document to a Selected Paper Size
• Using Watermarks
• Using Overlays

Printing Multiple Pages on One Sheet of Paper (N-Up Printing)

You can select the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will be reduced in size and arranged in the order you specify. You can print up to 16 pages on one sheet.

1 To change the print settings from your software application, access printer properties. See "Printing a Document" on page 12.
2 From the Layout tab, choose Multiple Pages per Side in the Layout Type drop-down list.
3 Select the number of pages you want to print per sheet (1, 2, 4, 6, 9, or 16) in the Pages per Side drop-down list.
4 Select the page order from the Pages Order drop-down list, if necessary.
   Check Print Page Border to print a border around each page on the sheet.
5 Click the Paper tab, select the paper source, size, and type.
6 Click OK and print the document.
Printing Posters

This feature allows you to print a single-page document onto 4, 9, or 16 sheets of paper, for the purpose of pasting the sheets together to form one poster-size document.

1. To change the print settings from your software application, access printer properties. See "Printing a Document" on page 12.

2. Click the Layout tab, select Poster Printing in the Layout Type drop-down list.

3. Configure the poster option:
   - You can select the page layout from Poster<2x2>, Poster<3x3>, Poster<4x4> or Custom. If you select Poster<2x2>, the output will be automatically stretched to cover 4 physical pages. If the option is set to Custom, you can enlarge the original from 150% to 400%.
   - Depending on the level of the enlargement, the page layout is automatically adjusted to Poster<2x2>, Poster<3x3>, Poster<4x4>.

4. Specify an overlap in millimeters or inches to make it easier to pasting the sheets together.

5. Click the Paper tab, select the paper source, size, and type.

6. Click OK and print the document. You can complete the poster by pasting the sheets together.

Printing Booklets

This printer feature allows you to print your document on both sides of the paper and arranges the pages so that the paper can be folded in half after printing to produce a booklet.

1. To change the print settings from your software application, access the printer properties. See "Printing a Document" on page 12.

2. From the Layout tab, choose Booklet Printing from the Type drop-down list.

   NOTE: The Booklet Printing option is not available for all paper sizes. In order to find out the available paper size for this feature, select the paper size in the Size option on the Paper tab, then check if the Booklet Printing in a Layout Type drop-down list on the Layout tab is activated.

3. Click the Paper tab, and select the paper source, size, and type.

4. Click OK and print the document.

5. After printing, fold and staple the pages.
Printing on Both Sides of Paper

You can print on both sides of a sheet of paper. Before printing, decide how you want your document oriented. The options are:

- **Printer Setting**, if you select this option, this feature is determined by the setting you’ve made on the control panel of the printer.
- **None**
- **Long Edge**, which is the conventional layout used in book binding.
- **Short Edge**, which is the type often used with calendars.
- **Reverse Duplex**, allows you to select general print order compare to duplex print order.

**NOTE:**

- Do not print on both sides of labels, transparencies, envelopes, or thick paper. Paper jamming and damage to the printer may result.
- To use double-sided printing, you can use only the following paper sizes: A4, Letter, Legal, Oficio and Folio, with a weight of 20~24 lbs (75~90 g/m²).

1. To change the print settings from your software application, access printer properties. "Printing a Document" on page 12.
2. From the Layout tab, select the paper orientation.
3. From the Double-sided Printing section, select the binding option you want.
4. Click the Paper tab and select the paper source, size, and type.
5. Click OK and print the document.

Printing a Reduced or Enlarged Document

You can change the size of a page’s content to appear larger or smaller on the printed page.

1. To change the print settings from your software application, access printer properties. See "Printing a Document" on page 12.
2. From the Paper tab, select Reduce/Enlarge in the Printing Type drop-down list.
3. Enter the scaling rate in the Percentage input box. You can also click the ▼ or ▲ button.
4. Select the paper source, size, and type in Paper Options.
5. Click OK and print the document.

Fitting Your Document to a Selected Paper Size

This printer feature allows you to scale your print job to any selected paper size regardless of the digital document size. This can be useful when you want to check fine details on a small document.

1. To change the print settings from your software application, access printer properties. See "Printing a Document" on page 12.
2. From the Paper tab, select Fit to Page in the Printing Type drop-down list.
3. Select the correct size from the Output size drop-down list.
4. Select the paper source, size, and type in Paper Options.
5. Click OK and print the document.
Using Watermarks

The Watermark option allows you to print text over an existing document. For example, you may want to have large gray letters reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a document.

There are several predefined watermarks that come with the printer, and they can be modified, or you can add new ones to the list.

Using an Existing Watermark

1. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 12.
2. Click the Extras tab, and select the desired watermark from the Watermark drop-down list. You will see the selected watermark in the preview image.
3. Click OK and start printing.

NOTE: The preview image shows how the page will look when it is printed.

Creating a Watermark

1. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 12.
2. Click the Extras tab, and click the Edit button in the Watermark section. The Edit Watermark window appears.
3. Enter a text message in the Watermark Message box.
   You can enter up to 40 characters. The message displays in the preview window.
   When the First Page Only box is checked, the watermark prints on the first page only.
4. Select watermark options.
   You can select the font name, style, size, or grayscale level from the Font Attributes section and set the angle of the watermark from the Message Angle section.
5. Click Add to add a new watermark to the list.
6. When you have finished editing, click OK and start printing.

To stop printing the watermark, select (No Watermark) from the Watermark drop-down list.

Editing a Watermark

1. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 12.
2. Click the Extras tab and click the Edit button in the Watermark section. The Edit Watermark window appears.
3. Select the watermark you want to edit from the Current Watermarks list and change the watermark message and options.
4. Click Update to save the changes.
5. Click OK until you exit the Print window.

Deleting a Watermark

1. To change the print settings from your software application, access printer properties. See “Printing a Document” on page 12.
2. From the Extras tab, click the Edit button in the Watermark section. The Edit Watermark window appears.
3. Select the watermark you want to delete from the Current Watermarks list and click Delete.
4. Click OK until you exit the Print window.
Using Overlays

What is an Overlay?
An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document. Overlays are often used to take the place of preprinted forms and letterhead paper. Rather than using preprinted letterhead, you can create an overlay containing the exact same information that is currently on your letterhead. To print a letter with your company's letterhead, you do not need to load preprinted letterhead paper in the printer. You need only tell the printer to print the letterhead overlay on your document.

Creating a New Page Overlay
To use a page overlay, you must create a new page overlay containing your logo or image.

1. Create or open a document containing text or an image for use in a new page overlay. Position the items exactly as you wish them to appear when printed as an overlay.
2. To save the document as an overlay, access printer properties. See "Printing a Document" on page 12.
3. Click the Extras tab, and click Edit button in the Overlay section.
4. In the Edit Overlay window, click Create Overlay.
5. In the Create Overlay window, type a name of up to eight characters in the File name box. Select the destination path, if necessary. (The default is C:\Formover).
6. Click Save. The name appears on the Overlay List box.
7. Click OK or Yes to finish creating.

The file is not printed. Instead it is stored on your computer hard disk drive.

NOTE: The overlay document size must be the same as the documents you print with the overlay. Do not create an overlay with a watermark.

Using a Page Overlay
After an overlay has been created, it is ready to be printed with your document. To print an overlay with a document:

1. Create or open the document you want to print.
2. To change the print settings from your software application, access printer properties. See "Printing a Document" on page 12.
3. Click the Extras tab.
4. Select the desired overlay from the Overlay drop-down list box.
5. If the overlay file you want does not appear in the Overlay list, click Edit button and Load Overlay, and select the overlay file.
   If you have stored the overlay file you want to use in an external source, you can also load the file when you access the Load Overlay window.
   After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the overlay from the Overlay List box.
6. If necessary, click Confirm Page Overlay When Printing. If this box is checked, a message window appears each time you submit a document for printing, asking you to confirm your wish to print an overlay on your document.
   If this box is not checked and an overlay has been selected, the overlay automatically prints with your document.
7. Click OK or Yes until printing begins.
   The selected overlay downloads with your print job and prints on your document.

NOTE: The resolution of the overlay document must be the same as that of the document you will print with the overlay.

Deleting a Page Overlay
You can delete page overlays that you no longer use.

1. In the printer properties window, click the Extras tab.
2. Click the Edit button in the Overlay section.
3. Select the overlay you want to delete from the Overlay List box.
4. Click Delete Overlay.
5. When a confirming message window appears, click Yes.
6. Click OK until you exit the Print window.
5 Using Windows PostScript Driver

If you want to use the PostScript driver provided with your system CD-ROM to print a document.

PPDs, in combination with the PostScript driver, access printer features and allow the computer to communicate with the printer. An installation program for the PPDs is provided on the supplied software CD-ROM.

This chapter includes:

---

Printer Settings

You can use the printer properties window, which allows you to access all of the printer options you need when using your printer. When the printer properties are displayed, you can review and change the settings needed for your print job.

Your printer properties window may differ, depending on your operating system. This Software User’s Guide shows the Properties window for Windows XP.

Your printer driver Properties window that appears in this User’s Guide may differ depending on the printer in use.

NOTES:

- Most Windows applications will override settings you specify in the printer driver. Change all print settings available in the software application first, and change any remaining settings using the printer driver.
- The settings you change remain in effect only while you are using the current program. To make your changes permanent, make them in the Printers folder.
- The following procedure is for Windows XP. For other Windows OS, refer to the corresponding Windows User’s Guide or online help.
  1. Click the Windows Start button.
  2. Select Printers and Faxes.
  3. Select your printer driver icon.
  4. Right-click on the printer driver icon and select Printing Preferences.
  5. Change the settings on each tab, click OK.

---

Advanced

You can use advanced settings by clicking the Advanced button.

- Paper/Output this option allows you to select the size of the paper loaded in tray.
- Graphic this option allows you to adjust the print quality for your specific printing needs.
- Document Options this options allow you to set the PostScript options or printer features.

Using Help

You can click  from the upper right corner of the window, and then click on any setting.
Using Utility Applications

If an error occurs while printing, the Status Monitor window appears, showing the error.

**NOTES:**
- To use this program, you need:
  - To check for Operating System(s) that are compatible with your printer, refer to Printer Specifications in your Printer User’s Guide.
  - Internet Explorer version 5.0 or higher for flash animation in HTML Help.
- If you need to know the exact name of your printer, you can check the supplied CD-ROM.

Using Printer Settings Utility

Using the Printer Settings Utility, you can configure and check print settings.

1. From the **Start** menu, select **Programs** or **All Programs** → your printer driver name → **Printer Settings Utility**.
2. Change the settings.
3. To send the changes to the printer, click the **Apply** button.

Using Onscreen Help

For more information about **Printer Settings Utility**, click [ ].

Opening the Troubleshooting Guide

Using the troubleshooting guide, you can view solutions for error status problems. Double click the Status Monitor icon on the Windows task bar. Or, from the **Start** menu, select **Programs** or **All Programs** → your printer driver name → **Troubleshooting Guide**.

Changing the Status Monitor Program Settings

Select the Status Monitor icon on the Windows task bar and right-click on the Status Monitor icon. Select **Options**. The following window opens.

- **Display when job is finished for network printer** shows the Status Monitor balloon when your job is complete. *(Only for a network supported printer.)*
- **Display when error occurs during printing** shows the Status Monitor balloon when an error occurs during printing.
- **Schedule an automatic status checking every** allows the computer to update the printer status regularly. Setting the value close to 1 second causes the computer to check the printer status more frequently, thereby allowing a faster response to any printer error.
Sharing the Printer Locally

You can connect the printer directly to a selected computer, which is called "host computer," on the network.

The following procedure is for Windows XP. For other Windows OS, refer to the corresponding Windows User's Guide or online help.

**NOTES:**
- Check the Operating System(s) that are compatible with your printer. Please refer to the OS Compatibility section of Printer Specifications in your Printer User's Guide.
- If you need to know the exact name of your printer, you can check the supplied CD-ROM.

### Setting Up a Host Computer

1. Start Windows.
2. From the **Start** menu select **Printers and Faxes**.
3. Double-click your **printer driver icon**.
4. From the **Printer** menu, select **Sharing**.
5. Check the **Share this printer** box.
6. Fill in the **Shared Name** field, and then click **OK**.

### Setting Up a Client Computer

1. Right-click the Windows **Start** button and select **Explore**.
2. Select **My Network Places** and then right-click **Search for Computers**.
3. Fill in the IP address of host computer in **Computer name** field, and click **Search**. (In case host computer requires **User name** and **Password**, fill in User ID and password of host computer account.)
4. Double-click **Printers and Faxes**.
5. Right-click printer driver icon, select **Connect**.
6. Click **Yes**, if the installation confirm message appears.
Using Your Printer in Linux

You can use your machine in a Linux environment.

This chapter includes:
- Getting Started
- Installing the Unified Linux Driver
- Using the Unified Driver Configurator
- Configuring Printer Properties
- Printing a Document

Getting Started

The supplied CD-ROM provides you with Xerox's Unified Linux Driver package for using your machine with a Linux computer. After the driver is installed on your Linux system, the driver package allows you to monitor a number of machine devices via fast ECP parallel ports and USB simultaneously.

The Unified Linux Driver package is supplied with a smart and flexible installation program. You don't need to search for additional components that might be necessary for the Unified Linux Driver software: all required packages will be carried onto your system and installed automatically; this is possible on a wide set of the most popular Linux clones.

Installing the Unified Linux Driver

1. Make sure that you connect your machine to your computer. Turn both the computer and the machine on.
2. When the Administrator Login window appears, type in root in the Login field and enter the system password.

   **NOTE:** You must log in as a super user (root) to install the printer software. If you are not a super user, ask your system administrator.

3. Insert the printer software CD-ROM. The CD-ROM will automatically run.

   If the CD-ROM does not automatically run, click the icon at the bottom of the desktop. When the Terminal screen appears, type in:

   ```
   [root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom
   [root@localhost root]#cd /mnt/cdrom/Linux
   [root@localhost root]#./install.sh
   ```

   If you still failed to run the CD-ROM, type the followings in sequence:

   ```
   [root@localhost root]#umount/dev/hdc
   [root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom
   ```

   **NOTE:** The installation program runs automatically if you have an autorun software package installed and configured.

4. When the welcome screen appears, click **Next**.
When the installation is complete, click **Finish**.

The installation program has added the Unified Driver Configurator desktop icon and Xerox Unified Driver group to the system menu for your convenience. If you have any difficulties, consult the onscreen help that is available through your system menu or can otherwise be called from the driver package windows applications, such as **Unified Driver Configurator**.

**NOTE**: Installing the driver in the text mode:
- If you do not use the graphical interface or have failed the driver installation, you have to use the driver in the text mode.
- Follow the step 1 to 3, then type `[root@localhost Linux]# ./install.sh`, than follow the instruction on the terminal screen. Then the installation completes.
- When you wan to uninstall the driver, follow the installation instruction above, but type `[root@localhost Linux]# ./uninstall.sh` on the terminal screen.

---

### Uninstalling the Unified Linux Driver

1. When the Administrator Login window appears, type in `root` in the Login field and enter the system password.

**NOTE**: You must log in as a super user (root) to install the printer software. If you are not a super user, ask your system administrator.

2. Insert the printer software CD-ROM. The CD-ROM will automatically run.

   If the CD-ROM does not automatically run, click the icon at the bottom of the desktop. When the Terminal screen appears, type in:

   ```
   [root@localhost root]# mount -t iso9660 /dev/hdc /mnt/cdrom
   [root@localhost root]# cd /mnt/cdrom/Linux
   [root@localhost root]# ./uninstall.sh
   ```

   **NOTE**: The installation program runs automatically if you have an autorun software package installed and configured.

3. Click **Uninstall**.
4. Click **Next**.

5. Click **Finish**.
Using the Unified Driver Configurator

Unified Linux Driver Configurator is a tool primarily intended for configuring Printer.

After installing the Unified Linux driver, the Unified Linux Driver Configurator icon will automatically be created on your desktop.

Opening the Unified Driver Configurator

1. Double-click **Unified Driver Configurator** on the desktop.

   You can also click the Startup Menu icon and select **Xerox Unified Driver** and then **Unified Driver Configurator**.

2. Press each button on the Modules pane to switch to the corresponding configuration window.

   You can use the onscreen help by clicking **Help**.

3. After changing the configurations, click **Exit** to close the Unified Driver Configurator.

Printers Configuration

Printers configuration has the two tabs: **Printers** and **Classes**.

Printers Tab

You can see the current system’s printer configuration by clicking on the printer icon button on the left side of the Unified Driver Configurator window.

- **Printers Configuration button**
- **Scanners Configuration button**
- **Ports Configuration button**

You can use the following printer control buttons:

- **Refresh**: renews the available printers list.
- **Add Printer**: allows you to add a new printer.
- **Remove Printer**: removes the selected printer.
- **Set as Default**: sets the current printer as a default printer.
- **Stop/Start**: stops/starts the printer.
- **Test**: allows you to print a test page to check if the machine is working properly.
- **Properties**: allows you to view and change the printer properties. For details, see page 29.
Classes Tab
The Classes tab shows a list of available printer classes.

- **Refresh**: Renews the classes list.
- **Add Class...**: Allows you to add a new printer class.
- **Remove Class**: Removes the selected printer class.

Ports Configuration
In this window, you can view the list of available ports, check the status of each port and release a port that is stalled in busy state when its owner is terminated for any reason.

- **Refresh**: Renews the available ports list.
- **Release port**: Releases the selected port.

Configuring Printer Properties
Using the properties window provided by the Printers configuration, you can change the various properties for your machine as a printer.

1. Open the Unified Driver Configurator.
   If necessary, switch to Printers configuration.
2. Select your machine on the available printers list and click **Properties**.
3. The Printer Properties window opens.
4. Click **OK** to apply the changes and close the Printer Properties Window.
Printing a Document

Printing from Applications

There are a lot of Linux applications that you are allowed to print from using Common UNIX Printing System (CUPS). You can print on your machine from any such application.

1. From the application you are using, select **Print** from the **File** menu.
2. Select **Print** directly using **lpr**.
3. In the LPR GUI window, select the model name of your machine from the Printer list and click **Properties**.
4. Change the printer and print job properties.
5. Click **Apply** to apply the changes and close the Properties window.
6. Click **OK** in the LPR GUI window to start printing.
7. The Printing window appears, allowing you to monitor the status of your print job.
   To abort the current job, click **Cancel**.

Printing Files

You can print many different types of files on the Xerox machine device using the standard CUPS way - directly from the command line interface. The CUPS lpr utility allows you to do that. But the drivers package replaces the standard lpr tool by a much more user-friendly LPR GUI program.

To print any document file:
1. Type `lpr <file_name>` from the Linux shell command line and press **Enter**. The LPR GUI window appears.
   When you type only `lpr` and press **Enter**, the Select file(s) to print window appears first. Just select any files you want to print and click **Open**.
2. In the LPR GUI window, select your printer from the list, and change the printer and print job properties.
   For details about the properties window, see page 30.
3. Click **OK** to start printing.
Using Your Printer with a Macintosh

Your printer supports Macintosh systems with a built-in USB interface or 10/100 Base-TX network interface card. When you print a file from a Macintosh computer, you can use the driver by installing the PPD file.

This chapter includes:

* Installing printer driver for Macintosh
* Setting Up the Printer
* Printing

## Installing printer driver for Macintosh

The PostScript driver CD-ROM that came with your machine provides you with the PPD file to use the PS driver, Apple LaserWriter driver, for printing on a Macintosh computer.

1. Connect your machine to the computer using the USB cable or the Ethernet cable.
2. Turn on your computer and the machine.
3. Insert the PostScript driver CD-ROM which came with your machine into the CD-ROM drive.
4. Double-click the **CD-ROM icon** that appears on your Macintosh desktop.
5. Double-click the **MAC_Installer** folder.
6. Double-click the **MAC_Printer** folder.
7. For Mac OS 10.3 or higher, double-click the **Xerox Phaser 3435_OSX** icon.
8. Select **Uninstall** and then click **Uninstall**.
9. Click **Continue**.
10. When the uninstallation is done, click **Quit**.

1. Connect your machine to the computer using the USB cable or the Ethernet cable.
2. Turn on your computer and the machine.
3. Insert the PostScript driver CD-ROM which came with your machine into the CD-ROM drive.
4. Double-click the **CD-ROM icon** that appears on your Macintosh desktop.
5. Double-click the **MAC_Installer** folder.
6. Double-click the **MAC_Printer** folder.
7. For Mac OS 10.3 or higher, double-click the **Xerox Phaser 3435_OSX** icon.
8. Enter the password and click **OK**.
9. Click **Continue**.
10. Select **Easy Install** and click **Install**.
11. After the installation is finished, click **Quit**.
Setting Up the Printer

Set up for your printer will be different depending on which cable you use to connect the printer to your computer—the network cable or the USB cable.

For a Network-connected Macintosh

**NOTE:** Some printers do not support a network interface. Before connecting your printer, make sure that your printer supports a network interface by referring to Printer Specifications in your Printer User’s Guide.

Mac OS 10.3 or higher

1. Follow the instructions on Installing printer driver for Macintosh on page 31 to install the PPD file on your computer.
2. Open **Print Center** or **Printer Setup Utility** from the Utilities folder.
   - For MAC OS 10.5, open **System Preferences** from the Applications folder, and click **Print & Fax**.
3. Click **Add** on the Printer List.
   - For MAC OS 10.5, press the “+” icon then a display window will pop up.
4. For MAC OS 10.3, select the **Rendezvous** tab.
   - For MAC OS 10.4, click Default Browser and find the Bonjour.
   - For MAC OS 10.5, click Default and find the Bonjour.
   The name of your machine appears on the list. Select XRX000xxxxxxxx from the printer box, where the xxxxxxxxx varies depending on your machine.
5. For MAC OS 10.3, if Auto Select does not work properly, select Xerox in **Printer Model** and your printer name in **Model Name**.
   - For MAC OS 10.4, if Auto Select does not work properly, select Xerox in **Print Using** and your printer name in **Model**.
   - For MAC OS 10.5, if Auto Select does not work properly, select Select a driver to use... and your printer name in **Print Using**.
   Your machine appears on the Printer List and is set as the default printer.
6. Click **Add**.

For a USB-connected Macintosh

Mac OS 10.3 or higher

1. Follow the instructions on Installing printer driver for Macintosh on page 31 to install the PPD file on your computer.
2. Open **Print Center** or **Printer Setup Utility** from the Utilities folder.
   - For MAC OS 10.5, open **System Preferences** from the Applications folder, and click **Print & Fax**.
3. Click **Add** on the Printer List.
   - For MAC OS 10.5, press the “+” icon then a display window will pop up.
4. For MAC OS 10.3, select the **USB** tab.
   - For MAC OS 10.4, click Default Browser and find the USB connection.
   - For MAC OS 10.5, click Default and find the USB connection.
5. Select your printer name.
6. For MAC OS 10.3, if Auto Select does not work properly, select Xerox in **Printer Model** and your printer name in **Model Name**.
   - For MAC OS 10.4, if Auto Select does not work properly, select Xerox in **Print Using** and your printer name in **Model**.
   - For MAC OS 10.5, if Auto Select does not work properly, select Select a driver to use... and your printer name in **Print Using**.
   Your machine appears on the Printer List and is set as the default printer.
7. Click **Add**.
Installable Options

After setting up for your printer, you can set some more detailed options.

1. Open Print Center or Printer Setup Utility from the Utilities folder.
   - For MAC OS 10.5, open System Preferences from the Applications folder, and click Print & Fax.
2. Select your printer model name.
3. Click Show Info.
   - For MAC OS 10.5, click Options & Supplies...
4. Select Installable Options tab.
   - For MAC OS 10.5, Select Driver tab.
5. Configure each items in Installable Options window.
   - Tray n: If the machine have optional tray n, you have to check the tray name.
   - Duplex Unit: If the machine has duplex unit, you have to check this item.
   - Printer Memory: If you installed additional printer memory, you have to configure the size of memory.
6. Select Apply Change.

Printing

NOTES:
- The Macintosh printer's properties window that appears in this User's Guide may differ depending on the printer in use. However the composition of the printer properties window is similar.
- You can check your printer name in the supplied CD-ROM.

Printing a Document

When you print with a Macintosh, you need to check the printer software setting in each application you use. Follow these steps to print from a Macintosh.

1. Open a Macintosh application and select the file you want to print.
2. Open the File menu and click Page Setup (Document Setup in some applications).
3. Choose your paper size, orientation, scaling, and other options and click OK.
4. Open the File menu and click Print.
5. Choose the number of copies you want and indicate which pages you want to print.
6. Click Print when you finish setting the options.
Changing Printer Settings

You can use advanced printing features when using your printer.
From your Macintosh application, select Print from the File menu. The printer name which appears in the printer properties window may differ depending on the printer in use. Except for the name, the composition of the printer properties window is similar.

Notes: The setting options may differ depending on printers and Macintosh OS version.

Layout

The Layout tab provides options to adjust how the document appears on the printed page. You can print multiple pages on one sheet of paper. Select Layout from the drop-down list to access the following features. For details, see "Printing Multiple Pages on One Sheet of Paper" on the next column.

• Pages per Sheet: This feature determines how many pages printed on one page. For details, see "Printing Multiple Pages on One Sheet of Paper" on page 35.

• Layout Direction: You can select the printing direction on a page as like the examples on UI.

Printer Features

This tab provides options for selecting the paper type and adjusting print quality. Select Printer Features from the drop-down list to access the following features:

• Reverse Duplex Printing: Allows you to select general print order compare to duplex print order.

• Fit to Page: This printer feature allows you to scale your print job to any selected paper size regardless of the digital document size. This can be useful when you want to check fine details on a small document.

• Paper Type: Set Type to correspond to the paper loaded in tray from which you want to print. This will let you get the best quality printout. If you load a different type of print material, select the corresponding paper type.

• Resolution(Quality): The Resolution options you can select may vary depending on your printer model. You can select the printing resolution. The higher the setting, the sharper the clarity of printed characters and graphics. The higher setting also may increase the time it takes to print a document.

• Toner Save Mode: Selecting this option extends the life of your print cartridge and reduces your cost per page without a significant reduction in print quality.
**Printing Multiple Pages on One Sheet of Paper**

You can print more than one page on a single sheet of paper. This feature provides a cost-effective way to print draft pages.

1. From your Macintosh application, select **Print** from the **File** menu.
2. Select **Layout**.

3. Select the number of pages you want to print on one sheet of paper on the **Pages per Sheet** drop-down list.
4. Select the page order from the **Layout Direction** option.
5. To print a border around each page on the sheet, select the option you want from the **Border** drop-down list.
6. Click **Print**, and the printer prints the selected number of pages on one side of each page.

▲ Mac OS 10.4

---

**Duplex Printing**

You can print on both sides of the paper. Before printing in the duplex mode, decide on which edge you will be binding your finished document. The binding options are:

- **Long-Edge Binding**: Which is the conventional layout used in book binding.
- **Short-Edge Binding**: Which is the type often used with calendars.

1. From your Macintosh application, select **Print** from the **File** menu.
2. Select the **Layout**.

3. Select a binding orientation from **Two Sided Printing** option.
4. Click **Print** and the printer prints on both sides of the paper.

▲ Mac OS 10.4

---

**CAUTION**: If you have selected duplex printing and then try to print multiple copies of a document, the printer may not print the document in the way you want. In case of "Collated copy", if your document has odd pages, the last page of the first copy and the first page of the next copy will be printed on the front and back of one sheet. In case of "Uncollated copy", the same page will be printed on the front and back of one sheet. Therefore, if you need multiple copies of a document and you want those copies on both sides of the paper, you must print them one at a time, as separate print jobs.
SOFTWARE SECTION

INDEX

A
advanced printing, use 18

B
booklet printing 19

D
Device 30
document, print
Macintosh 33
Windows 12
double-sided printing 20

E
Extras properties, set 16

F
favorites settings, use 17

G
Graphics 15
Graphics properties, set 15

H
help, use 17, 23

I
install
Linux 26
printer driver
Macintosh 31
Windows 4

L
Layout properties, set

Macintosh 34
Windows 14

Linux
driver, install 26
printer properties 29
printing 30

M
Macintosh
driver
install 31
printing 33
setting up the printer 32

N
n-up printing
Macintosh 35
Windows 18

O
orientation, print 30
Windows 14
overlay
create 22
delete 22
print 22

P
Paper properties, set 14
paper size, set 14
print 30
er paper source, set 30
Windows 15
paper type, set
Macintosh 34
print 30
poster, print 19
PostScript driver
installing 23
print

booklets 19
document 12
double-sided 20
fit to page 20
from Linux 30
from Macintosh 33
from Windows 12
N-up
Macintosh 35
Windows 18
overlay 22
poster 21
PRN 13
scaling 20
watermark 21
Print Features properties
Macintosh 34
printer driver
install
Macintosh 31
printer driver, install
Linux 26
printer properties
Linux 30
printer properties, set
Macintosh 34
Windows 13, 23
printer resolution, set
Macintosh 34
Windows 15
printer software
install
Windows 4, 11
uninstall
Windows 10

S
setting
favorites 17
Print All Text To Black 16
resolution 15
Macintosh 34
Windows 15
toner save mode 15
true-type option 15
software
install
    Macintosh 31
    Windows 4, 11
reinstall
    Windows 10
system requirements
    Macintosh 31
uninstall
    Macintosh 31
    Windows 10
status monitor, use 24

T
toner save, set 15, 34

U
uninstall, software
    Linux 27
    Macintosh 31
    Windows 10

W
watermark
    create 21
    delete 21
    edit 21
    print 21